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Notice
While reasonable efforts have been made to ensure that the 
information in this document is complete and accurate at the time 
of printing, Avaya assumes no liability for any errors. Avaya reserves 
the right to make changes and corrections to the information in this 
document without the obligation to notify any person or organization 
of such changes.
Documentation disclaimer
“Documentation” means information published in varying media 
which may include product information, subscription or service 
descriptions, operating instructions and performance specifications 
that are generally made available to users of products. 
Documentation does not include marketing materials. Avaya shall 
not be responsible for any modifications, additions, or deletions 
to the original published version of Documentation unless such 
modifications, additions, or deletions were performed by or on the 
express behalf of Avaya. End user agrees to indemnify and hold 
harmless Avaya, Avaya's agents, servants and employees against 
all claims, lawsuits, demands and judgments arising out of, or in 
connection with, subsequent modifications, additions or deletions to 
this documentation, to the extent made by End user.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked 
websites referenced within this site or Documentation provided by 
Avaya. Avaya is not responsible for the accuracy of any information, 
statement or content provided on these sites and does not 
necessarily endorse the products, services, or information described 
or offered within them. Avaya does not guarantee that these links will 
work all the time and has no control over the availability of the linked 
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software. 
Please refer to your agreement with Avaya to establish the terms of 
the limited warranty. In addition, Avaya’s standard warranty language 
as well as information regarding support for this product while under 
warranty is available to Avaya customers and other parties through 
the Avaya Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link 
“Warranty & Product Lifecycle” or such successor site as designated 
by Avaya. Please note that if the product(s) was purchased from an 
authorized Avaya channel partner outside of the United States and 
Canada, the warranty is provided by said Avaya Channel Partner and 
not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that 
You acquire from either Avaya or an authorized Avaya Channel 
Partner (as applicable) and which is described further in Hosted SAS 
or other service description documentation regarding the applicable 
hosted service. If You purchase a Hosted Service subscription, 
the foregoing limited warranty may not apply but You may be 
entitled to support services in connection with the Hosted Service 
as described further in your service description documents for the 
applicable Hosted Service. Contact Avaya or Avaya Channel Partner 
(as applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN 
AVAYA HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR 
AN AVAYA CHANNEL PARTNER (AS APPLICABLE), THE TERMS 
OF USE FOR HOSTED SERVICES ARE AVAILABLE ON THE 
AVAYA WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO 
UNDER THE LINK “Avaya Terms of Use for Hosted Services” 
OR SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND 
ARE APPLICABLE TO ANYONE WHO ACCESSES OR USES THE 
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED 
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON 
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE 
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY 
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. 
IF YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A 
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT 
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE 

TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, 
OR IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF 
USE, YOU MUST NOT ACCESS OR USE THE HOSTED SERVICE 
OR AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED 
SERVICE.
Licenses
The Global Software License Terms (“Software License Terms”) 
are available on the following website https://www.avaya.com/en/
legal-license-terms/ or any successor site as designated by Avaya. 
These Software License Terms are applicable to anyone who 
installs, downloads, and/or uses Software and/or Documentation. By 
installing, downloading or using the Software, or authorizing others to 
do so, the end user agrees that the Software License Terms create 
a binding contract between them and Avaya. In case the end user is 
accepting these Software License Terms on behalf of a company or 
other legal entity, the end user represents that it has the authority to 
bind such entity to these Software License Terms.
Copyright
Except where expressly stated otherwise, no use should be made 
of materials on this site, the Documentation, Software, Hosted 
Service, or hardware provided by Avaya. All content on this site, the 
documentation, Hosted Service, and the product provided by Avaya 
including the selection, arrangement and design of the content is 
owned either by Avaya or its licensors and is protected by copyright 
and other intellectual property laws including the sui generis rights 
relating to the protection of databases. You may not modify, copy, 
reproduce, republish, upload, post, transmit or distribute in any way 
any content, in whole or in part, including any code and software 
unless expressly authorized by Avaya. Unauthorized reproduction, 
transmission, dissemination, storage, or use without the express 
written consent of Avaya can be a criminal, as well as a civil offense 
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine. 
Each product has its own ordering code and license types. Unless 
otherwise stated, each Instance of a product must be separately 
licensed and ordered. For example, if the end user customer or 
Avaya Channel Partner would like to install two Instances of the 
same type of products, then two products of that type must be 
ordered.
Third Party Components
The following applies only if the H.264 (AVC) codec is distributed 
with the product. THIS PRODUCT IS LICENSED UNDER THE AVC 
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A 
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH 
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC 
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE 
IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, 
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL 
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR 
EMBED THE H.264 CODEC OR H.265 CODEC, THE AVAYA 
CHANNEL PARTNER ACKNOWLEDGES AND AGREES THE 
AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND 
ALL RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC) 
CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO 
LICENSE FOR THE PERSONAL USE OF A CONSUMER 
OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO: (i) ENCODE VIDEO IN COMPLIANCE WITH 
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC 
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE 
IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) 
CODECS MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.

https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
https://support.avaya.com/LicenseInfo
https://www.avaya.com/en/legal-license-terms/
https://www.avaya.com/en/legal-license-terms/
HTTP://WWW.MPEGLA.COM
HTTP://WWW.MPEGLA.COM
HTTP://WWW.MPEGLA.COM


Compliance with Laws
You acknowledge and agree that it is Your responsibility to comply 
with any applicable laws and regulations, including, but not limited 
to laws and regulations related to call recording, data privacy, 
intellectual property, trade secret, fraud, and music performance 
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications 
system by an unauthorized party (for example, a person who is not a 
corporate employee, agent, subcontractor, or is not working on your 
company's behalf). Be aware that there can be a risk of Toll Fraud 
associated with your system and that, if Toll Fraud occurs, it can 
result in substantial additional charges for your telecommunications 
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You 
need technical assistance or support, please contact your Avaya 
Sales Representative.
Security Vulnerabilities
Information about Avaya’s security support policies can be 
found in the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled 
per the Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this 
site, the Documentation, Hosted Service(s), and product(s) provided 
by Avaya are the registered or unregistered Marks of Avaya, its 
affiliates, its licensors, its suppliers, or other third parties. Users 
are not permitted to use such Marks without prior written consent 
from Avaya or such third party which may own the Mark. Nothing 
contained in this site, the Documentation, Hosted Service(s) and 
product(s) should be construed as granting, by implication, estoppel, 
or otherwise, any license or right in and to the Marks without the 
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya LLC.
All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and 
other countries.
Downloading Documentation
For the most current versions of Documentation, see the Avaya 
Support website: https://support.avaya.com, or such successor site 
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for 
Product or Cloud Service notices and articles, or to report a 
problem with your Avaya Product or Cloud Service. For a list of 
support telephone numbers and contact addresses, go to the Avaya 
Support website: https://support.avaya.com (or such successor site 
as designated by Avaya), scroll to the bottom of the page, and select 
Contact Avaya Support.
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https://support.avaya.com/css/P8/documents/100161515
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Chapter 1: Introduction

Purpose
This document provides procedures for deploying the Avaya Experience Portal virtual application 
in the Avaya Customer Experience Virtualized Environment. This document includes installation, 
configuration, initial administration, troubleshooting, and basic maintenance checklists and 
procedures.

The primary audience for this document is anyone who is involved with installing, configuring, 
and verifying Avaya Experience Portal in a VMware® vSphere™ virtualization environment at 
a customer site. The audience includes and is not limited to implementation engineers, field 
technicians, business partners, solution providers, and customers.

This document does not include optional or customized aspects of a configuration.
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Chapter 2: Architecture overview

Avaya Customer Experience Virtualized Environment 
overview

Avaya Customer Experience Virtualized Environment integrates Avaya Aura® Contact Center 
applications with VMware® virtualized server architecture. Avaya Customer Experience Virtualized 
Environment provides the following benefits:

• simplifies IT management by providing common software administration and maintenance.

• requires fewer servers and racks which reduces the footprint.

• lowers power consumption and cooling requirements.

• enables capital equipment cost savings.

• lowers operational expenses.

• uses standard operating procedures for both Avaya and non-Avaya products.

• customers can deploy Avaya products in a virtualized environment on customer-specified 
servers and hardware.

• businesses can scale rapidly to accommodate growth and to respond to changing business 
requirements.

For existing customers who have a VMware IT infrastructure, Avaya Customer Experience 
Virtualized Environment provides an opportunity to upgrade to the next release level of 
collaboration using their own VMware infrastructure.

The Avaya Customer Experience Virtualized Environment project is only for VMware and is not 
intended to include any other industry hypervisor.

Note:

This document uses the following terms, and at times, uses the terms interchangeably.

• server and host

• reservations and configuration values

Customer deployment
Deployment into the blade, cluster, and server is managed by vCenter Server and vSphere Client.
The customer provides the servers and the VMware infrastructure including the VMware licenses.
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Software delivery
The software is delivered as one or more pre-packaged Open Virtualization Appliance (OVA) 
files that are posted on the Avaya Product Licensing and Download System (PLDS). Each OVA 
contains the following components:

• the application software and operating system.
• pre-installed VMware tools.
• preset configuration details for

- RAM and CPU reservations and storage requirements
- Network Interface Card (NIC)

Patches and upgrades
A minimum patch level can be required for each supported application. See the compatibility 
matrix tool at http://support.avaya.com/CompatibilityMatrix/Index.aspx for more information 
regarding the application patch requirements.

Important:
Do not upgrade the VMware tools software that is packaged with each OVA unless instructed 
to do so by Avaya. The supplied version is the supported release and has been thoroughly 
tested.

Performance and capacities
The OVA template is built with configuration values which optimize performance and follow 
recommended Best Practices.

Caution:
Modifying these values can have a direct impact on the performance, capacity, and stability of 
the virtual machine. It is the responsibility of the customer to understand the aforementioned 
impacts when changing configuration values. Avaya Global Support Services (GSS) may not 
be able to assist in fully resolving a problem if the resource allocation has been changed for a 
virtual application. Avaya GSS could require the customer to reset the values to the optimized 
values before starting to investigate the issue.

Experience Portal server configuration options
Experience Portal for the virtualized environment supports both multiple server and single server 
setups.

• The multiple server setup includes two or more virtual machines, one dedicated to running 
the Primary EPM software and at least one dedicated to the MPP software.  

• In a single server setup, the Primary EPM and the MPP software are located on the same 
virtual machine. The single server configuration can be deployed with an optional co-resident 
application server.

Experience Portal server configuration options 
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Virtualized components
Software component Description
ESXi Host The physical machine running the ESXi Hypervisor software.
ESXi Hypervisor A platform that runs multiple operating systems on a host computer at 

the same time.
vSphere Client vSphere Client is an application that installs and manages virtual 

machines. vSphere Client connects to a vCenter server or directly to an 
ESXi host if a vCenter Server is not used. The application is installed 
on a personal computer or accessible through a web interface. The 
installable vSphere Client is not available in vSphere 6.5 and later 
releases.

vSphere Web Client Using a Web browser, vSphere Web Client connects to a vCenter 
server or directly to an ESXi host if a vCenter Server is not used.

vSphere Client (HTML5) vSphere Client (HTML5) is available in vSphere 6.5. Using a Web 
browser, it connects to a vCenter server or directly to an ESXi host 
if a vCenter Server is not used. This is the only vSphere client 
administration tool after the next vSphere release.

vCenter Server vCenter Server provides centralized control and visibility at every level 
of the virtual infrastructure. vCenter Server provides VMware features 
such as High Availability and vMotion.

Appliance Virtualization Platform Avaya-provided virtualization turnkey solution that includes the 
hardware and all the software including the VMware hypervisor.

Solution Deployment Manager Centralized software management solution of Avaya that provides 
deployment, upgrade, migration, and update capabilities for the Avaya 
Aura® virtual applications.

Open Virtualization Appliance 
(OVA)

The virtualized OS and application packaged in a single file that is used 
to deploy a virtual machine.

Deployment guidelines
• Deploy maximum number of virtualized environments on the same host.

• Deploy the virtualized environment on the same cluster if the cluster goes beyond the host 
boundary.

• Segment redundant elements on a different cluster, or ensure that the redundant elements 
are not on the same host.

• Create a tiered or segmented cluster infrastructure that isolates critical applications, such as 
CMS, from other virtual machines.

• Plan for rainy day scenarios or conditions. Do not configure resources only for traffic or 
performance on an average day.

Architecture overview
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• Do not oversubscribe resources. Oversubscribing affects performance.

• Monitor the server, host, and virtualized environment performance.

Deployment guidelines

November 2024 Deploying Experience Portal in an Avaya Customer Experience Virtualized Environment 11
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingExperiencePortalinanAvayaCustomerExperienceVirtualizedEnvironment&p3=13


Chapter 3: Planning and configuration

Planning
Ensure that the following activities have been completed before deploying the virtual appliance:

# Action Notes

1 Coordinate with service providers.
2 All required licenses have been 

purchased and are accessible.
3 Staging and verification activities have 

been planned and resources assigned.

Server hardware and resources
VMware offers compatibility guides that list servers, system, I/O, storage/SAN, and backup 
compatibility with VMware infrastructure. See http://www.vmware.com/resources/guides.html to 
view VMware-certified compatibility guides and product interoperability matrixes.
The VMware-certified servers must be running on ESXi 6.5 or newer version. Avaya-provided ASP 
130 R5 servers is delivered with ESXi 7.0 from September 2021.

Configuration tools and utilities
Ensure that the following tools and utilities are available before you deploy Experience Portal:

• Experience Portal OVAs.
You can download Experience Portal OVAs from the Avaya Product Licensing and Delivery 
System (PLDS) website.

• A computer with the VMware vSphere client that can route to the VMware server.
• The Avaya Enhanced Access Security Gateway (EASG) or Secure Access Link (SAL) tool.

Avaya service technicians use EASG or SAL to remotely log in to the servers that are under 
a service agreement.
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• The order number of the customer.
• The Avaya WebLM license server OVA, Avaya WebLM license server, or the built-in Avaya 

WebLM for Primary EPM.

Note:
Do not use the Avaya WebLM license server if you install the local WebLM installed with 
Experience Portal .
WebLM manages the licensing of Experience Portal. For more information about 
the Avaya WebLM OVA, see Deploying Avaya Experience Portal in an Avaya 
Customer Experience Virtualized Environment on the Avaya Support website at https://
support.avaya.com.

Experience Portal Virtual Machine resource requirements
Before you deploy each Experience Portal virtual machine, ensure that the following set of 
resources are available on the ESXi host.

VMware resource Value
CPU 4 virtual sockets

1 core per socket
vCPU reservation 9500 MHz
Memory reservation 4 GB
Storage reservation 160 GB
Shared NICs 1 Gbps or more

VMware software requirements
The following VMware software versions are supported along with any available updates:

• VMware ESXi 6.5, 6.7, 7.0, or 8.0 version
• VMware vCenter Server 6.5, 6.7, 7.0, or 8.0 version

See VMware Product Interoperability Matrixes at http://partnerweb.vmware.com/
comp_guide2/sim/interop_matrix.php to view compatibility with other solution releases.

Note:
Avaya-provided ASP 130 R4 and R5 servers support VMware ESXi 6.5, 7.0, and 8.0 
respectively. Customer-provided platforms support all three ESXi versions.

AEP OVAs fail to deploy on older versions of VMWare ESXi. Ensure that your ESXi is updated to 
the latest VMWare release.

Experience Portal Virtual Machine resource requirements
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Avaya Experience Portal is verified on the following ESXi versions:
• ESXi 6.5 P04
• ESXi 6.7 P01
• ESXi 7.0 Update 2a
• ESXi 8.0 U3

Compatible Web browsers
Experience Portal supports the following Web browsers:

• Microsoft Internet Explorer 11
• Mozilla FireFox latest version

OVA profile sizes and capacities
Experience Portal 8.1 OVAs have the following deployment options:

MPP Profiles EPM Profiles
Profile Label Port Capacity Resources Profile label Resources

Entry 250 4 vCPU + 4 GB RAM N/A 6 vCPU + 12 GB RAM
Small 500 8 vCPU + 8 GB RAM
Medium (Typical) 1000 8 vCPU + 16 GB RAM
Large 1500 12 vCPU + 24 GB RAM

Important:
Profile size recommendations are based on performance test results obtained from testing 
with G.711 and G.729 codecs. Note the following considerations:

• Call scenarios are based on simple call flows. Increasingly complex call flows may 
require an increase to resource allocation.

• VMware Host server has Intel(R) Xeon(R) Gold 6230 CPU @ 2.10GHz CPUs that may 
deliver improved performance over other CPUs. Lower benchmarked CPUs may require 
an increase to resource allocation.

Default configuration data
The following table identifies the default parameters that are provided by the OVA files.

Planning and configuration
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OVA type Parameter Value
Primary EPM

Auxiliary EPM

Destination directory /opt/Avaya/ExperiencePortal

Primary EPM Username and password 
entered during OVA 
deployment

No

Primary EPM

Auxiliary EPM

MPP

Root access to Linux Username: root

Password: rootpw

Username: root

Changed password: _______
Primary EPM

Auxiliary EPM

MPP

Change root access to 
Linux

Username: root

Default password: rootpw

Changed password: _______
Primary EPM

Auxiliary EPM

MPP

Non-root access to Linux Username: cust

Password: custpw

Changed password: _______
Primary EPM

Auxiliary EPM

MPP

Change non-root access to 
Linux

Username: cust

Password: custpw

Changed password: _______
Primary EPM

Auxiliary EPM

Password for postgres 
database account

Automatically generated

Primary EPM

Auxiliary EPM

Create database account 
that can read report data

No

Primary EPM

Auxiliary EPM

Create database account 
that can write report data

No

Primary EPM Support auxiliary EPM 
servers

No

Primary EPM

Auxiliary EPM

MPP

Security Certificate Automatically generated

Customer configuration data worksheet
The following table identifies the key configuration information that you must enter throughout the 
Experience Portal deployment and configuration process.

Customer configuration data worksheet
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Required data Value for the system Note
Fully qualified domain name 
(FQDN) of the virtual machine

Value: ———————

IP address of the virtual machine Value: ———————
Netmask of the virtual machine Value: ———————
IP address of the network gateway Value: ———————
IP address of the DNS server that is 
assigned to the virtual machine

Value: ——————— The comma or semicolon 
separated list of DNS servers 
for the virtual machine.

This information is optional.
Default search list Value: ——————— The comma or semicolon 

separated list of Search 
Domains.

This information is optional.
Product ID Value: ——————— The 10-digit, alphanumeric 

Product ID. You are prompted 
for this information only 
during the primary EPM OVA 
deployment.

IP address of the primary EPM Value: ——————— You are prompted for this 
information only during only 
during the auxiliary EPM OVA 
and MPP OVA deployment.

EASG Value: ———————

Note:
Complete this worksheet for each virtual machine that you plan to deploy.

Planning and configuration
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Chapter 4: Deploying Experience Portal

Overview
The Experience Portal virtualized environment offer consists of the following three OVA files:

• Primary EPM

• Auxiliary EPM

• MPP

You can configure WebLM on the Primary EPM OVA.

You can also deploy the Avaya WebLM OVA packaged for VMware if you do not have a WebLM 
server that is being used to license an Experience Portal system. You can also use the WebLM 
built into the Primary EPM.

For more information about Avaya WebLM OVA, see Avaya WebLM using VMware® in 
the Virtualized Environment Deployment Guide on the Avaya Support website at https://
support.avaya.com.

The Experience Portal OVA files support the following two methods of deployment:

• vCenter deployment through a vSphere client

• Direct deployment to the ESXi server through a vSphere client

You can select one of the two methods of deployment based on your VMware environment.

In a single server setup, you must install only the Primary EPM OVA and then enable the co-
resident MPP.

In a multiple server setup, you must deploy the OVA files in the following order:

1. Avaya WebLM OVA. If you do not already have a WebLM server, skip this step to use the 
WebLM built into the Primary EPM.

2. Primary EPM OVA.

3. Auxiliary EPM OVA and MPP OVA in any order after you deploy and configure the Primary 
EPM OVA.
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Deploying the Primary EPM OVA with vCenter
About this task
If vSphere Client is connected to vCenter, use this procedure to deploy the Primary EPM OVA.

Note:
The following steps are guidelines to deploying the OVA. The deployment screens might differ 
based on your VMware configuration.

Procedure
1. Connect to the vCenter server through the vSphere client.

2. In the vSphere Client window, select File > Deploy OVF Template.

3. In the Deploy OVF Template window, perform one of the following to select the Primary 
EPM OVA file, and click Next:
• If you have downloaded the OVA file to a location accessible from your computer, click 

Browse to select the location.

• If the OVA file is located on an HTTP server, enter the full URL in the Deploy from a file 
or URL field.

Important:

Ensure that you use a high speed network, 1-Gbps or more, to connect to the source 
location of the OVA file. A slow network connection might increase the deployment 
time or cause the deployment to time-out.

4. Verify the details of the primary EPM OVA template.

5. Verify and accept the license agreement.

6. Enter a unique name for the new virtual machine.

7. Select the inventory location for the virtual machine.

8. Select the host or cluster on which you want to deploy the virtual machine if you did not 
make a selection at the start of the deployment process.

9. Select the resource pool if the host or cluster has resource pools.

10. Select the datastore location to store the virtual machine files.

The datastore can be local to the host or a mounted shared storage, such as 
Network Filesystem Storage (NFS) or Storage Area Network (SAN). The virtual machine 
configuration file and virtual disk files are stored in the datastore. Select a datastore that 
can store the virtual machine and the virtual disk files.

11. Select the desired disk format to store the virtual machine and the virtual disk.

Deploying Experience Portal
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Note:

Using Thick Provision Lazy Zero disks is suggested. For more information about thin 
vs thick deployments and best practices for VMware features, see Avaya Customer 
Experience Virtualized Environment Solution Description.

12. If the deployment wizard displays the Network Mapping window, verify the Destination VM 
Networks setting, and update the details if required.

Note:

Based on your VMware configuration, the wizard might prompt you to verify and 
change the Network Mapping details.

13. Configure the network settings by entering values for the following fields:

• Fully Qualified Domain Name (FQDN) of this virtual machine

• IP address of this virtual machine

• Netmask of this virtual machine

• IP address of the network gateway

• (Optional) IP addresses of the DNS servers (separate addresses with a semicolon or a 
comma)

• (Optional) List of Search Domains (separate domains with a semicolon)

• Product ID of the Experience Portal system

• Admin Username of the Experience Portal system

• Admin Password of the Experience Portal system

Experience Portal Admin username and password is used to create an admin account 
for login VPMS web management.

• Enable Auxiliary Server to create the database vpcommon account for the Auxiliary 
EPM server.

The values are Yes or No. If you select Yes, enter the Auxiliary Server Password.

The Auxiliary Server Username vpcommon cannot be changed.

• Enable Report Reader to create a report reader account on primary database.

The values are Yes or No. If you select Yes, then enter following details:

- Report Reader Username

- Report Reader Password

Note:

If you enter invalid network settings during the deployment procedure, the system 
prompts you to configure the network settings again after you restart the virtual 
machine and log in to the console as the root user.

Deploying the Primary EPM OVA with vCenter
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14. Configure EASG.

The system displays the EASG Acceptance of Terms page. Perform one of the following 
steps:

• Select Yes to enable EASG.

With the Enable EASG option, you gain access to all Avaya Services Login during the 
primary EPM installation.

• Select No to disable EASG.

With the Disable EASG option, you cannot log in to the Experience Portal server with 
any Avaya Services Login during the primary EPM installation.

The system applies this selection to other systems within the Experience Portal system 
including MPP and auxiliary EPMs. If you restore a backup later, either as part of an 
Experience Portal upgrade, or a normal backup/restore procedure, the system might 
override your selection by using the one restored from the backup.

15. Verify the deployment properties and complete the deployment procedure.

The current EPM OVA requires 6 CPUs and 12 GB RAM. However EPM can still run under 
2 CPU/4 GB RAM. For information on profile sizes and capacities, see OVA profile sizes 
and capacities on page 14.

Also, see Rescaling OVA hardware settings on page 75 if you want to change the CPU/
Memory size.

16. (Optional) To automatically start the virtual machine after the deployment procedure is 
complete, select the Power on after deployment check box in the Ready to Complete 
window.

If you do not select this check box, you can manually start the virtual machine after the 
deployment procedure is complete.

Next steps
1. If you did not select the option to start the virtual machine automatically, start the virtual 

machine.
2. Login to the virtual machine console as cust using password custpw, wait for the console 

to display System Configuration Finished, this process usually takes less than 
20 minutes. If the process takes long time, check the corresponding installation logs 
under /opt/Avaya/InstallLogs. When the system configuration is finished, switch to 
root account using su – and setup the account password through the mandatory process.

Note:
On the root login, the Avaya First Login Experience will run forcing the user to set 
the boot loader password and to change the root and cust passwords. The default 
passwords for root and cust accounts are rootpw and custpw respectively. You can 
gain access to the sroot and craft accounts if EASG is enabled.

3. Deploy MPP servers.
4. (Optional) Deploy auxiliary EPM servers.

Deploying Experience Portal
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5. (Optional) Enable the co-resident MPP.

Deploying the Auxiliary EPM OVA with vCenter
About this task
If vSphere Client is connected to vCenter, use this procedure to deploy the Auxiliary EPM OVA.

Note:
The following steps are guidelines to deploying the OVA. The deployment screens might differ 
based on your VMware configuration.

Before you begin
• Deploy and configure the Primary EPM OVA. Ensure that the installation is finished and the 

Primary EPM OVA is up and running before deploying the Auxiliary EPM.
• Configure the primary EPM server to support one or more auxiliary EPM servers.

Procedure
1. Connect to the vCenter server through the vSphere client.

2. In the vSphere Client window, select File > Deploy OVF Template.

3. In the Deploy OVF Template window, perform one of the following to select the Auxiliary 
EPM OVA file, and click Next:
• If you have downloaded the OVA file to a location accessible from your computer, click 

Browse to select the location.

• If the OVA file is located on an HTTP server, enter the full URL in the Deploy from a file 
or URL field.

Important:

Ensure that you use a high speed network, 1-Gbps or more, to connect to the source 
location of the OVA file. A slow network connection might increase the deployment 
time or cause the deployment to time-out.

4. Verify the details of the auxiliary EPM OVA template.

5. Verify and accept the license agreement.

6. Enter a unique name for the new virtual machine.

7. Select the inventory location for the virtual machine.

8. Select the host or cluster on which you want to deploy the virtual machine if you did not 
make a selection at the start of the deployment process.

9. Select the resource pool if the host or cluster has resource pools.

10. Select the datastore location to store the virtual machine files.

Deploying the Auxiliary EPM OVA with vCenter
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The datastore can be local to the host or a mounted shared storage, such as 
Network Filesystem Storage (NFS) or Storage Area Network (SAN). The virtual machine 
configuration file and virtual disk files are stored in the datastore. Select a datastore that 
can store the virtual machine and the virtual disk files.

11. Select the required disk format to store the virtual machine and the virtual disks.

Note:

Deploy thick disks which are Thick Provision Lazy Zeroed. For more information 
about thin vs thick deployments and best practices for VMware features, see Avaya 
Customer Experience Virtualized Environment Solution Description.

12. If the deployment wizard displays the Network Mapping window, verify the Destination VM 
Networks setting, and update the details if required.

Note:

Based on your VMware configuration, the wizard might prompt you to verify and 
change the Network Mapping details.

13. Configure the network settings by entering values for the following fields:

• Fully Qualified Domain Name (FQDN) of this virtual machine

• IP address of this virtual machine

• Netmask of this virtual machine

• IP address of the network gateway

• (Optional) IP addresses of the DNS servers (separate addresses with a semicolon or a 
comma)

• (Optional) List of Search Domains (separate domains with a semicolon)

• Hostname (FQDN) of the Primary EPM server

• IP address of the Primary EPM server

• Enable Auxiliary Server to create the database vpcommon account for Auxiliary EPM 
server to connect to Primary EPM server.

The values are Yes or No. If you select Yes, enter the Database vpcommon Password.

The Auxiliary Server Username vpcommon cannot be changed.

• Enable DB Report Writer to create Database Report Writer account.

The values are Yes or No. If you select Yes, then enter following details:

- DB Report Writer Username

- DB Report Writer Password

• Enable DB Report Reader to create Database Report Reader account.
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The values are Yes or No. If you select Yes, then enter following details:

- DB Report Reader Username

- DB Report Reader Password

Note:

If you enter incorrect Primary EPM information or Network Information, the 
configuration process fails and you are prompted to redeploy the Auxiliary EPM.

During Auxiliary EPM software installation, the system sets the EASG state as the 
same EASG state of the Primary EPM, if the Auxiliary EPM server does not have an 
EASG state. If the Auxiliary EPM server is set to disable EASG, ensure that you have 
access to the system without the Avaya Service Logins. Ensure that you have root 
access without using the sroot user.

14. Verify the deployment properties and complete the deployment procedure.

The current EPM OVA requires 6 CPUs and 12 GB RAM. However EPM can still run under 
2 CPU/4 GB RAM. For information on profile sizes and capacities, see OVA profile sizes 
and capacities on page 14.

Also, see Rescaling OVA hardware settings on page 75 if you want to change the CPU/
Memory size.

15. (Optional) To automatically start the virtual machine after the deployment procedure is 
complete, select the Power on after deployment check box in the Ready to Complete 
window.

If you do not select this check box, you can manually start the virtual machine after the 
deployment procedure is complete.

Next steps
1. If you did not select the option to start the virtual machine automatically, start the virtual 

machine.
2. Login to the virtual machine console as cust using password custpw, wait for the console 

to display System Configuration Finished, this process usually takes less than 
20 minutes. If the process takes long time, check the corresponding installation logs 
under /opt/Avaya/InstallLogs. When the system configuration is finished, switch to 
root account using su – and setup the account password through the mandatory process.

Note:
On the root login, the Avaya First Login Experience will run forcing the user to set 
the boot loader password and to change the root and cust passwords. The default 
passwords for root and cust accounts are rootpw and custpw respectively. You can 
gain access to the sroot and craft accounts if EASG is enabled, and only by Avaya 
technicians.

3. Deploy MPP servers.

Deploying the Auxiliary EPM OVA with vCenter
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Deploying the MPP OVA with vCenter
About this task
If vSphere Client is connected to vCenter, use this procedure to deploy the MPP OVA.

Note:
The following steps are guidelines to deploying the OVA. The deployment screens might differ 
based on your VMware configuration.

Before you begin
Deploy and configure the Primary EPM OVA. Ensure that the installation is finished and the 
Primary EPM OVA is up and running before deploying the MPP.

Procedure
1. Connect to the vCenter server through the vSphere client.

2. In the vSphere Client window, select File > Deploy OVF Template.

3. In the Deploy OVF Template window, perform one of the following to select the MPP OVA 
file, and click Next:
• If you have downloaded the OVA file to a location accessible from your computer, click 

Browse to select the location.

• If the OVA file is located on an HTTP server, enter the full URL in the Deploy from a file 
or URL field.

Important:

Ensure that you use a high speed network, 1-Gbps or more, to connect to the source 
location of the OVA file. A slow network connection might increase the deployment 
time or cause the deployment to time-out.

4. Verify the details of the MPP OVA template.

5. Verify and accept the license agreement.

6. Select a Profile from the following options:

• Entry

• Small

• Medium (Typical)

• Large

For information on profile sizes and capacities, see OVA profile sizes and capacities on 
page 14.

Also, see Rescaling OVA hardware settings on page 75 if you want to change the CPU/
Memory size.

7. Select an appropriate virtual machine deployment configuration.
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8. Enter a unique name for the new virtual machine.

9. Select the inventory location for the virtual machine.

10. Select the host or cluster if you have not selected a host at the start of the deployment 
process.

11. Select the resource pool if the host or cluster has resource pools.

12. Select the datastore location to store the virtual machine files.

The datastore can be local to the host or a mounted shared storage, such as 
Network Filesystem Storage (NFS) or Storage Area Network (SAN). The virtual machine 
configuration file and virtual disk files are stored in the datastore. Select a datastore that 
can store the virtual machine and the virtual disk files.

13. Select the required disk format to store the virtual machine and the virtual disks.

Note:

Deploy thick disks which are Thick Provision Lazy Zeroed. For more information 
about thin vs thick deployments and best practices for VMware features, see Avaya 
Customer Experience Virtualized Environment Solution Description.

14. If the deployment wizard displays the Network Mapping window, verify the Destination VM 
Networks setting, and update the details if required.

Note:

Based on your VMware configuration, the wizard might prompt you to verify and 
change the Network Mapping details.

15. Configure the network settings by entering values for the following fields:

• Fully Qualified Domain Name (FQDN) of this virtual machine

• IP address of this virtual machine

• Netmask of this virtual machine

• IP address of the network gateway

• (Optional) IP addresses of the DNS servers (separate addresses with a semicolon or a 
comma)

• (Optional) List of Search Domains (separate domains with a semicolon)

• Hostname (FQDN) of the Primary EPM server

• IP address of the Primary EPM server

Note:

If you enter incorrect Primary EPM information or Network information, the 
configuration process fails and you are prompted to redeploy the MPP server.

During MPP software installation, the system sets the EASG state as the same EASG 
state of the Primary EPM if the Auxiliary EPM server does not have an EASG state. 
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If the MPP server is set to disable EASG, ensure that you have access to the system 
without the Avaya Service Logins. Ensure that you have root access without using the 
root.

16. Verify the deployment properties and complete the deployment procedure.

17. (Optional) To automatically start the virtual machine after the deployment procedure is 
complete, select the Power on after deployment check box in the Ready to Complete 
window.

If you do not select this check box, you can manually start the virtual machine after the 
deployment procedure is complete.

Next steps
1. If you did not select the option to start the virtual machine automatically, start the virtual 

machine.
2. Login to the virtual machine console as cust using password custpw, wait for the console 

to display System Configuration Finished, this process usually takes less than 
20 minutes. If the process takes long time, check the corresponding installation logs 
under /opt/Avaya/InstallLogs. When the system configuration is finished, switch to 
root account using su – and setup the account password through the mandatory process.

Note:
On the root login, the Avaya First Login Experience will run forcing the user to set 
the boot loader password and to change the root and cust passwords. The default 
passwords for root and cust accounts are rootpw & custpw respectively. You can 
gain access to the sroot and craft accounts if EASG is enabled, and only by Avaya 
technicians.

3. Configure the MPP server.

Deploying the Primary EPM OVA on Avaya Solutions 
Platform (ASP) 130 using ESXi Embedded Host Client

About this task
Use this procedure to deploy Primary EPM OVA files on ASP 130 (Profile 4 and 5), using an ESXi 
Embedded Host Client.

Note:
You can also use this process to deploy an OVA direct to a customer supplied host using the 
host client.

Before you begin
Ensure that ESXi 6.5, 7.5, or 8.0 is installed on ASP 130 R4 or R5 servers respectively.
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Procedure
1. Download and deploy the ISO on your local machine to connect to the ESXi host server 

without vCenter.

This is recommended even when you have vCenter.

2. Right click on the host and select Create > Register VM.

3. Select File > Deploy OVF Template.

4. In the Deploy OVF Template window, perform one of the following to select the Primary 
EPM OVA file, and click Next:
• If you have downloaded the OVA file to a location accessible from your computer, click 

Browse to select the location.

• If the OVA file is located on an HTTP server, enter the full URL in the Deploy from a file 
or URL field.

Important:

Ensure that you use a high speed network, 1-Gbps or more, to connect to the source 
location of the OVA file. A slow network connection might increase the deployment 
time or cause the deployment to time-out.

5. Verify the details of the primary EPM OVA template.

6. Verify and accept the license agreement.

7. Enter a unique name for the new virtual machine.

8. Select the inventory location for the virtual machine.

9. Select the host or cluster on which you want to deploy the virtual machine if you did not 
make a selection at the start of the deployment process.

10. Select the resource pool if the host or cluster has resource pools.

11. Select the datastore location to store the virtual machine files.

The datastore can be local to the host or a mounted shared storage, such as 
Network Filesystem Storage (NFS) or Storage Area Network (SAN). The virtual machine 
configuration file and virtual disk files are stored in the datastore. Select a datastore that 
can store the virtual machine and the virtual disk files.

12. Select the desired disk format to store the virtual machine and the virtual disk.

Note:

Using Thick Provision is suggested. For more information about thin vs thick 
deployments and best practices for VMware features, see Avaya Customer Experience 
Virtualized Environment Solution Description.

13. If the deployment wizard displays the Network Mapping window, verify the Destination VM 
Networks setting, and update the details if required.
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Note:

Based on your VMware configuration, the wizard might prompt you to verify and 
change the Network Mapping details.

14. Configure the network settings by entering values for the following fields:

• Fully Qualified Domain Name (FQDN) of this virtual machine

• IP address of this virtual machine

• Netmask of this virtual machine

• IP address of the network gateway

• (Optional) IP addresses of the DNS servers (separate addresses with a semicolon or a 
comma)

• (Optional) List of Search Domains (separate domains with a semicolon)

• Product ID of the Experience Portal system

• Admin Username of the Experience Portal system

• Admin Password of the Experience Portal system

Note:

Experience Portal Admin Username and Password is used to create an admin 
account to log on to the VPMS web management portal.

• Enable Auxiliary Server to create the database vpcommon account for the Auxiliary 
EPM server.

The values are Yes or No. If you select Yes, enter the Auxiliary Server Password.

The Auxiliary Server Username vpcommon cannot be changed.

• Enable Report Reader to create a report reader account on primary database.

The values are Yes or No. If you select Yes, then enter following details:

- Report Reader Username

- Report Reader Password

Note:

If you enter invalid network settings during the deployment procedure, the system 
prompts you to configure the network settings again after you restart the virtual 
machine and log in to the console as the root user.

15. Configure EASG.

The system displays the EASG Acceptance of Terms page. Perform one of the following 
steps:

• Select Yes to enable EASG.
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With the Enable EASG option, you gain access to all Avaya Services Login during the 
primary EPM installation.

• Select No to disable EASG.

With the Disable EASG option, you cannot log in to the Experience Portal server with 
any Avaya Services Login during the primary EPM installation.

The system applies this selection to other systems within the Experience Portal system 
including MPP and auxiliary EPMs. If you restore a backup later, either as part of an 
Experience Portal upgrade, or a normal backup/restore procedure, the system overrides 
your selection by using the one restored from the backup.

16. Verify the deployment properties and complete the deployment procedure.

The current EPM OVA requires 6 CPUs and 12 GB RAM. However EPM can still run under 
2 CPU/4 GB RAM. For information on profile sizes and capacities, see OVA profile sizes 
and capacities on page 14.

Also, see Rescaling OVA hardware settings on page 75 if you want to change the CPU/
Memory size.

17. (Optional) To automatically start the virtual machine after the deployment procedure is 
complete, select the Power on after deployment check box in the Ready to Complete 
window.

If you do not select this check box, you can manually start the virtual machine after the 
deployment procedure is complete.

Next steps
1. If you did not select the option to start the virtual machine automatically, start the virtual 

machine.
2. Login to the virtual machine console as cust using password custpw, wait for the console 

to display System Configuration Finished, this process usually takes less than 
20 minutes. If the process takes long time, check the corresponding installation logs 
under /opt/Avaya/InstallLogs. When the system configuration is finished, switch to 
root account using su – and setup the account password through the mandatory process.

Note:
On the root login, the Avaya First Login Experience will run forcing the user to set 
the boot loader password and to change the root and cust passwords. The default 
passwords for root and cust accounts are rootpw and custpw respectively. You can 
gain access to the sroot and craft accounts if EASG is enabled.

3. Deploy MPP servers.
4. (Optional) Deploy auxiliary EPM servers.
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Deploying the Auxiliary EPM OVA on Avaya Solutions 
Platform (ASP) 130 using ESXi Embedded Host Client

About this task
Use this procedure to deploy the Auxiliary Experience Portal OVA files on ASP 130 (Profile 4 and 
5), using an ESXi Embedded Host Client.

Note:
You can also use this process to deploy an OVA direct to a customer supplied host using the 
host client. The deployment screens might differ based on your VMware configuration.

Before you begin
Deploy and configure the Primary EPM OVA.
Configure the primary EPM server to support one or more auxiliary EPM servers.
Ensure that ESXi 6.5, 7.0, or 8.0 is installed on ASP 130 R4 or R5 servers respectively.

Procedure
1. Download and deploy the ISO on your local machine to connect to the ESXi host server 

without vCenter.

2. In the vSphere Client window, select File > Deploy OVF Template.

3. In the Deploy OVF Template window, perform one of the following to select the Auxiliary 
EPM OVA file, and click Next:
• If you have downloaded the OVA file to a location accessible from your computer, click 

Browse to select the location.

• If the OVA file is located on an HTTP server, enter the full URL in the Deploy from a file 
or URL field.

Important:

Ensure that you use a high speed network, 1-Gbps or more, to connect to the source 
location of the OVA file. A slow network connection might increase the deployment 
time or cause the deployment to time-out.

4. Verify the details of the auxiliary EPM OVA template.

5. Verify and accept the license agreement.

6. Enter a unique name for the new virtual machine.

7. Select the inventory location for the virtual machine.

8. Select the host or cluster on which you want to deploy the virtual machine if you did not 
make a selection at the start of the deployment process.

9. Select the resource pool if the host or cluster has resource pools.

10. Select the datastore location to store the virtual machine files.
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The datastore can be local to the host or a mounted shared storage, such as 
Network Filesystem Storage (NFS) or Storage Area Network (SAN). The virtual machine 
configuration file and virtual disk files are stored in the datastore. Select a datastore that 
can store the virtual machine and the virtual disk files.

11. Select the required disk format to store the virtual machine and the virtual disks.

Note:

Deploy thick disks which are Thick Provision. For more information about thin vs thick 
deployments and best practices for VMware features, see Avaya Customer Experience 
Virtualized Environment Solution Description.

12. If the deployment wizard displays the Network Mapping window, verify the Destination VM 
Networks setting, and update the details if required.

Note:

Based on your VMware configuration, the wizard might prompt you to verify and 
change the Network Mapping details.

13. Configure the network settings by entering values for the following fields:

• Fully Qualified Domain Name (FQDN) of this virtual machine

• IP address of this virtual machine

• Netmask of this virtual machine

• IP address of the network gateway

• (Optional) IP addresses of the DNS servers (separate addresses with a semicolon or a 
comma)

• (Optional) List of Search Domains (separate domains with a semicolon)

• Hostname (FQDN) of the Primary EPM server

• IP address of the Primary EPM server

• Enable Auxiliary Server to create the database vpcommon account for the Auxiliary 
EPM server to connect to the Primary EPM server.

The values are Yes or No. If you select Yes, then enter the Database vpcommon 
Password.

The Database vpcommon Username cannot be changed.

• Enable DB Report Writer to create Database Report Writer account.

The values are Yes or No. If you select Yes, then enter following details:

- DB Report Writer Username

- DB Report Writer Password

• Enable DB Report Reader to create Database Report Reader account.
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The values are Yes or No. If you select Yes, then enter following details:

- DB Report Reader Username

- DB Report Reader Password

Note:

If you enter incorrect Primary EPM information or Network Information, the 
configuration process fails and you are prompted to redeploy the Auxiliary EPM.

During Auxiliary EPM software installation, the system sets the EASG state as the 
same EASG state of the Primary EPM, if the Auxiliary EPM server does not have an 
EASG state. If the Auxiliary EPM server is set to disable EASG, ensure that you have 
access to the system without the Avaya Service Logins. Ensure that you have root 
access without using the sroot user.

14. Verify the deployment properties and complete the deployment procedure.

The current EPM OVA requires 6 CPUs and 12 GB RAM. However EPM can still run under 
2 CPU/4 GB RAM. For information on profile sizes and capacities, see OVA profile sizes 
and capacities on page 14.

Also, see Rescaling OVA hardware settings on page 75 if you want to change the CPU/
Memory size.

15. (Optional) To automatically start the virtual machine after the deployment procedure is 
complete, select the Power on after deployment check box in the Ready to Complete 
window.

If you do not select this check box, you can manually start the virtual machine after the 
deployment procedure is complete.

Next steps
1. If you did not select the option to start the virtual machine automatically, start the virtual 

machine.
2. Login to the virtual machine console as cust using password custpw, wait for the console 

to display System Configuration Finished, this process usually takes less than 
20 minutes. If the process takes long time, check the corresponding installation logs 
under /opt/Avaya/InstallLogs. When the system configuration is finished, switch to 
root account using su – and setup the account password through the mandatory process.

Note:
On the root login, the Avaya First Login Experience will run forcing the user to set 
the boot loader password and to change the root and cust passwords. The default 
passwords for root and cust accounts are rootpw and custpw respectively. You can 
gain access to the sroot and craft accounts if EASG is enabled, and only by Avaya 
technicians.

3. Deploy MPP servers.
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Deploying the MPP Experience Portal OVA on Avaya 
Solutions Platform (ASP) 130 using ESXi Embedded Host 
Client

About this task
Use this procedure to deploy an MPP Experience Portal OVA files on ASP 130 (Profile 4 and 5), 
using an ESXi Embedded Host Client.

Note:
You can also use this process to deploy an OVA direct to a customer supplied host using the 
host client. The deployment screens might differ based on your VMware configuration.

Before you begin
Deploy and configure the Primary EPM OVA.
Ensure that ESXi 6.5, 7.0, or 8.0 is installed on ASP 130 R4 or R5 servers respectively.

Procedure
1. Download and deploy the ISO on your local machine to connect to the ESXi host server 

without vCenter.

2. In the vSphere Client window, select File > Deploy OVF Template.

3. In the Deploy OVF Template window, perform one of the following to select the MPP OVA 
file, and click Next:
• If you have downloaded the OVA file to a location accessible from your computer, click 

Browse to select the location.
• If the OVA file is located on an HTTP server, enter the full URL in the Deploy from a file 

or URL field.

Important:

Ensure that you use a high speed network, 1-Gbps or more, to connect to the source 
location of the OVA file. A slow network connection might increase the deployment 
time or cause the deployment to time-out.

4. Verify the details of the MPP OVA template.

5. Verify and accept the license agreement.

6. Select a Profile from following options:

• Entry
• Small
• Medium (Typical)
• Large

For information on profile sizes and capacities, see OVA profile sizes and capacities on 
page 14.
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Also, see Rescaling OVA hardware settings on page 75 if you want to change the CPU/
Memory size.

7. Select an appropriate virtual machine deployment configuration.

8. Enter a unique name for the new virtual machine.

9. Select the inventory location for the virtual machine.

10. Select the host or cluster if you have not selected a host at the start of the deployment 
process.

11. Select the resource pool if the host or cluster has resource pools.

12. Select the datastore location to store the virtual machine files.

The datastore can be local to the host or a mounted shared storage, such as 
Network Filesystem Storage (NFS) or Storage Area Network (SAN). The virtual machine 
configuration file and virtual disk files are stored in the datastore. Select a datastore that 
can store the virtual machine and the virtual disk files.

13. Select the required disk format to store the virtual machine and the virtual disks.

Note:

Deploy thick disks which are Thick Provision. For more information about thin vs thick 
deployments and best practices for VMware features, see Avaya Customer Experience 
Virtualized Environment Solution Description.

14. If the deployment wizard displays the Network Mapping window, verify the Destination VM 
Networks setting, and update the details if required.

Note:

Based on your VMware configuration, the wizard might prompt you to verify and 
change the Network Mapping details.

15. Configure the network settings by entering values for the following fields:

• Fully Qualified Domain Name (FQDN) of this virtual machine

• IP address of this virtual machine

• Netmask of this virtual machine

• IP address of the network gateway

• (Optional) IP addresses of the DNS servers (separate addresses with a semicolon or a 
comma)

• (Optional) List of Search Domains (separate domains with a semicolon)

• Hostname (FQDN) of the Primary EPM server

• IP address of the Primary EPM server
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Note:

If you enter incorrect Primary EPM information or Network information, the 
configuration process fails and you are prompted to redeploy the MPP server.

During MPP software installation, the system sets the EASG state as the same EASG 
state of the Primary EPM if the Auxiliary EPM server does not have an EASG state. 
If the MPP server is set to disable EASG, ensure that you have access to the system 
without the Avaya Service Logins. Ensure that you have root access without using the 
root.

16. Verify the deployment properties and complete the deployment procedure.

17. (Optional) To automatically start the virtual machine after the deployment procedure is 
complete, select the Power on after deployment check box in the Ready to Complete 
window.

If you do not select this check box, you can manually start the virtual machine after the 
deployment procedure is complete.

Next steps
1. If you did not select the option to start the virtual machine automatically, start the virtual 

machine.
2. Login to the virtual machine console as cust using password custpw, wait for the console 

to display System Configuration Finished, this process usually takes less than 
20 minutes. If the process takes long time, check the corresponding installation logs 
under /opt/Avaya/InstallLogs. When the system configuration is finished, switch to 
root account using su – and setup the account password through the mandatory process.

Note:
On the root login, the Avaya First Login Experience will run forcing the user to set 
the boot loader password and to change the root and cust passwords. The default 
passwords for root and cust accounts are rootpw & custpw respectively. You can 
gain access to the sroot and craft accounts if EASG is enabled, and only by Avaya 
technicians.

3. Configure the MPP server.

Deploying Avaya Proactive Outreach Manager on 
Experience Portal OVA

For more information, see installing Avaya Proactive Outreach Manager (POM) on Experience 
Portal section in Implementing Avaya Proactive Outreach Manager guide on Avaya Support site 
http://support.avaya.com.
Also see, Deploying Experience Portal and Avaya Proactive Outreach Manager on Amazon Web 
Services guide on Avaya Support site http://support.avaya.com.
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Deploying Intelligent Customer Routing on Experience 
Portal OVA

For more information, see Configuring Experience Portal section in Implementing Intelligent 
Customer Routing (ICR) guide on Avaya Support site http://support.avaya.com.

Deploying the EPM OVA on a single server
About this task
For a single server deployment, you must install only the Primary EPM OVA. You can re-run the 
installer to install a co-resident MPP on the Primary EPM OVA.

Procedure
1. Deploy the Primary EPM OVA.

For more information, see Deploying the Primary EPM OVA with vCenter on page 18.

2. Open a putty session on the Primary EPM OVA and log on with root access.

3. Run the following command: cd /etc/EPRPM.

4. Run the following command: bash aepinstall.sh
5. Accept the License agreement.

The system displays the following options:
-------------------------------------------------------------------------------
Select re-install type:

1) Install MPP on Primary EPM (Convert to Single Server)
2) Re-install software preserving Configuration and Application Data
3) Re-install software deleting Configuration and Application Data
4) Exit

6. Select option 1.

The co-resident MPP is installed on the Primary EPM.

Optional: Single server Avaya Experience Portal and Application 
server configuration

If you install Avaya Experience Portal, EPM, and the media server software on the same server, 
you can also install a Tomcat application on that server. Avaya supports Tomcat 8.x or later 
versions.

Avaya Experience Portal includes an installation script for the Tomcat 8.5.42 application server. 
You can also do a manual installation of this Tomcat application server.
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For detailed information about installing a Tomcat application server on the Experience Portal 
server, see Implementing Avaya Experience Portal on a single server.
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Chapter 5: Configuration

Configuring the virtual machine automatic startup settings
About this task
Configure the virtual machine to automatically start after a power failure or restart of the 
hypervisor. The default is set to no.
In high availability (HA) clusters, the VMware HA software ignores the startup selections.

Procedure
1. In the navigation pane, click the host where the virtual machine is located.

2. Click Manage.

3. In Virtual Machines, click VM Startup/Shutdown, and then click Edit.

The software displays the Edit VM Startup and Shutdown window.

4. Click Automatically start and stop the virtual machines with the system.

5. Click OK.

Example
The following is an example of the Virtual Machine Startup/Shutdown screen.

November 2024 Deploying Experience Portal in an Avaya Customer Experience Virtualized Environment 38
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingExperiencePortalinanAvayaCustomerExperienceVirtualizedEnvironment&p3=13


Configuring and initializing the Experience Portal system

Checklist for configuring basic Experience Portal system
After you deploy the Experience Portal OVA files, you can configure and test an Experience Portal 
system.

Important:
Complete the following steps in the specified order or you might encounter errors during the 
configuration procedures.

Step Description Notes

1 Set up EASG if the Avaya Services team need to access 
the Avaya Experience Portal system.

See Enhanced Access 
Security Gateway 
(EASG) on page 42.

2 Log in to the EPM web interface. See Logging in to the 
Experience Portal web 
interface on page 53.

Table continues…
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Step Description Notes

3 Install the Experience Portal license file.

Note:

Experience Portal provides 10 telephony ports in 
the 30-day grace period after deployment. After the 
grace period expires, and if you have not installed 
a valid license file, the Experience Portal system 
stops processing calls.

See Installing a license 
file on page 53.

4 Add H.323 connections or add at least one SIP 
connection.

See Administering Avaya 
Experience Portal.

5 Add the MPP servers.

Note:

Ensure that you select the Restart Automatically 
option on the Add MPP server page in EPM so that 
the MPP is available to take calls in the following 
conditions:

• The virtual machine starts automatically when the 
host is restarted.

• The VMware High Availability feature is in use 
and the host starts up on a different ESXi host.

See Administering Avaya 
Experience Portal.

6 (Optional) Add one or more Automatic Speech 
Recognition (ASR) servers.

See Administering Avaya 
Experience Portal.

7 Add one or more Text-to-Speech (TTS) servers. See Administering Avaya 
Experience Portal.

Table continues…
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Step Description Notes

8 If you deploy one or more auxiliary EPM servers, you 
must do the following:

• Configure the primary EPM virtual machine

• Configure the auxiliary EPM.

• Verify that the primary EPM and auxiliary EPM servers 
can communicate with each other using either of the 
following options:

- A Domain Name Server (DNS) to translate 
hostnames to their corresponding IP addresses

- The /etc/hosts file to map the IP addresses and 
hostnames

See:

• Configuring primary 
EPM server to support 
one or more auxiliary 
EPM servers on 
page 55.

• Configuring password 
for database user 
vpcommon on an 
auxiliary EPM on 
page 56.

• Note:

For more 
information 
on verifying 
communication 
between the 
primary EPM 
server and all 
other servers, 
see Implementing 
Avaya Experience 
Portal on multiple 
servers.

9 If you have deployed auxiliary EPM servers, add the 
auxiliary EPM servers.

See Administering Avaya 
Experience Portal.

10 Connect the EPM server to an external time source 
so that all servers in the Experience Portal system are 
synchronized.

See Implementing Avaya 
Experience Portal on 
multiple servers.

11 Configure EPM accepts inputs in non-English 
languages.

See Implementing Avaya 
Experience Portal on 
multiple servers.

12 To enable multi-tenancy in Experience Portal, run the 
EnableOrganizations command.

See Administering Avaya 
Experience Portal.

13 Start all MPP servers. See Administering Avaya 
Experience Portal.

14 If the system/virtual machine BIOS has the Universal 
Time Coordinated (UTC) set as True, you must 
configure the UTC while setting the time zone on Avaya 
Linux.

See Changing the 
timezone on Avaya 
Linux on page 56.
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Enhanced Access Security Gateway (EASG)
EASG provides a secure method for Avaya services personnel to access Avaya Experience Portal 
remotely and on-site. Access is under the control of the customer and can be enabled or disabled 
at any time. EASG must be enabled for Avaya Services to perform tasks necessary for the 
ongoing support, management, and solution optimization. EASG is also required to enable remote 
proactive support tools such as Avaya Expert Systems® and Avaya Healthcheck.

The EASG authentication method is based on cryptographic signature verification of responses 
using the certificates that Avaya issues.

The following are the key points for EASG implementation:

• The old ASG (Avaya Security Gateway) is obsolete. The ASG RPM (asgtools) is removed 
during the Avaya Experience Portal installation process.

• The Avaya Service Account authentication file is no longer used to control access to services 
logins.

• Avaya Services Logins supported in Avaya Experience Portal EASG are init, inads, craft, 
and sroot. EASG does not affect the permissions associated with Avaya Services Logins. 
For more information about Avaya Services Logins, see Avaya Services Logins supported by 
EASG on page 42.

Note:

The rasaccess account is disabled and not supported.

Avaya Service Logins supported by EASG
User name Group Purpose
sroot root, avayavpgroup Avaya Services root access
craft susers, avayavpgroup Avaya Services non-root access
init susers Avaya Services non-root access
inads susers Avaya Services non-root access
init Administration, Auditor, User 

manager, Privacy manager roles
EPM service user account

Avaya Experience Portal product certificate
Avaya Experience Portal installer installs a dedicated Avaya Experience Portal 8.x product 
certificate at the /etc/asg/Product.p7b directory in each server. The product certificate is 
x509v3 compliant and is derived from Avaya IT Root CA. It uniquely identifies the major releases 
of Avaya Experience Portal to the Avaya EASG backend server.

Product certificate contents
To view the contents of the product certificate, you must run the EASGProductCert --
certInfo command.

Example:

Configuration
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EASGProductCert --certInfo
Subject: CN=Avaya Experience Portal  8.1, OU=EASG, O=Avaya Inc.
Serial Number: 10001
Expiration: Jul 27 04:00:00 2031 GMT
Trust Chain:
1. O=Avaya, OU=IT, CN=AvayaITrootCA2
2. DC=com, DC=avaya, DC=global, CN=AvayaITserverCA2
3. O=Avaya Inc, OU=EASG, CN=EASG Intermediate CA 
4. CN=Product EASG Intermediate CA, OU=EASG, O=Avaya Inc.
5. CN=Avaya Experience Portal  8.1, OU=EASG, O=Avaya Inc.
Product certificate update
Every major release requires the generation of a new EASG product certificate. The Avaya 
Experience Portal 8.x product certificate shipped with the 8.x release is the EASG product 
certificate for all Avaya Experience Portal 8.x releases.
If the product certificate is deleted, modified, or replaced illegally, Avaya can no longer provide 
remote access support to the customer.
If the Avaya backend server revokes the Avaya Experience Portal 8.x product certificate, only a 
software patch or new software release can replace the revoked certificate.

Product certificate monitoring
The Avaya Experience Portal 8.x EASG product certificate is valid for 15 years. The primary EPM 
raises major alarms when the product certificate approaches the following expiration days:

• EASG Product certificate expiration pending:
- 365 days
- 180 days
- 30 days

• EASG Product Certificate expired.

EASG Acceptance of Terms
Avaya Experience Portal displays the following EASG Acceptance of Terms during the installation 
of the primary EPM of Avaya Experience Portal. The message displays only if the user did not 
configure EASG on the primary EPM or when the user runs the EASGConfigure.sh script on 
any Avaya Experience Portal server.

Enable (recommended)
By enabling Avaya Logins you are granting Avaya access to your system. This is 
necessary to maximize the performance and value 
of your Avaya support entitlements, allowing Avaya to resolve product issues in a 
timely manner.
In addition to enabling the Avaya Logins, this product should be registered with Avaya 
and technically onboarded for 
remote connectivity and alarming. Please see the Avaya support site (support.avaya.com/
registration) for additional 
information for registering products and establishing remote access and alarming.

Disable
By disabling Avaya Logins you are preventing Avaya access to your system. This is not 
recommended, as it impacts Avaya’s 
ability to provide support for the product. Unless the customer is well versed in 
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managing the product themselves, 
Avaya Logins should not be disabled.

Important:
The EASG selection the user makes during the primary EPM installation is applied to other 
systems within the Experience Portal system, including new MPPs and auxiliary EPMs, which 
are subsequently installed.

EASG states
The following are the valid EASG states:

• Enabled EASG: The state that the user selects to enable EASG during the primary EPM 
installation. The user can also run the EASGConfigure.sh script to enable EASG. When 
EASG is enabled, access to all Avaya Services Logins is EASG protected.

• Disabled EASG: The state that the user selects to disable EASG during the primary EPM 
installation. The user can also run the EASGConfigure.sh script to disable EASG. When 
EASG is disabled, it is impossible to log in to the Avaya Experience Portal server with any 
Avaya Services Login.

Important:
• The user uses the EASGConfigure.sh script to enable or disable EASG after installing 

Experience Portal.

• Users with root privileges or users who belong to the susers group can run the 
EASGConfigure.sh script to enable or disable EASG.

Note:

The primary EPM software installation always displays the Acceptance of Terms prompt to 
enable or disable EASG if EASG is not installed. The auxiliary EPM and MPP software 
installation queries the primary EPM EASG state and set the same EASG state if EASG is not 
installed.

Enabling EASG
About this task
Use the EASGConfigure.sh script to enable EASG on an Avaya Experience Portal server. After 
EASG is enabled, the Avaya Services Logins accounts are EASG protected. Use the challenge-
response authentication to log in to the Avaya Experience Portal server.

Note:
• Using EASGConfigure.sh script to enable EASG on an Avaya Experience Portal server 

does not enable EASG on other existing servers in the Avaya Experience Portal system. 
To enable EASG on other servers, run the script on each server.

• Users with root privileges or users who belong to the susers group can run the 
EASGConfigure.sh to enable EASG.
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Before you begin
• Ensure that the server has a non-Avaya service account with root privilege or a user that 

belongs to the susers group to run the EASGConfigure.sh script.
• You cannot log in to the Experience Portal server with an Avaya Services Login account if the 

current state of the server is disabled.

Procedure
1. Log on to the Avaya Experience Portal Linux server in one of the following ways:

• Log in locally as a user with root privilege or as a user who belongs to the susers group.
• Log in remotely as a non-root user, and then enter the su - command to change the 

user to a user with root privileges or a user that belongs to the susers group.

2. Navigate to the $AVAYA_HOME/Support/Security-Tools/EASG directory where the 
script is located.

3. Run the bash EASGConfigure.sh --enable command.

The script displays the Acceptance of terms prompt for enabling EASG.

For example:
bash EASGConfigure.sh --enable
Invocation at Tue Apr 25 16:35:50 PDT 2017
LOG FILE: /opt/Avaya/ExperiencePortal/logs/EASGConfigure/
EASGConfigure.sh.2017-04-25.log
Enhanced Access Security Gateway (EASG)
EASG is disabled
By enabling Avaya Services Logins you are granting Avaya access to your system. 

This is required to maximize the performance and value of your Avaya support 
entitlements, allowing Avaya to resolve product issues in a timely manner. The 
product must be 
registered using the Avaya Global Registration Tool (GRT, see https://
grt.avaya.com) to be eligible for Avaya remote 
connectivity. Please see the Avaya support site (https://support.avaya.com/
registration) for additional information for 
registering products and establishing remote access and alarming.
Do you want to enable EASG [yes/no]?

4. Type one of the following:

• yes to accept the EASG terms.
• no to cancel.

5. Review the output and debug log from the /opt/Avaya/ExperiencePortal/logs/
EASGConfigure directory to ensure that the script completes successfully.

Disabling EASG
About this task
Use the EASGConfigure.sh script to disable EASG on an Avaya Experience Portal server.
After EASG is disabled:

• Avaya Services Logins accounts are blocked from logging in to the Avaya Experience Portal 
server.
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• The EPM service account init is blocked from logging in to the primary EPM.

Note:
• Using the EASGConfigure.sh script to disable EASG on an Avaya Experience Portal 

server does not disable EASG on other existing servers in the Avaya Experience Portal 
system. To disable EASG on other servers, run the script on each server.

• Users with root privileges or users who belong to the susers group can run the 
EASGConfigure.sh to disable EASG.

Before you begin
Ensure that the server has a non-Avaya service account with root privilege or a user that belongs 
to susers group to run the EASGConfigure.sh script.

Procedure
1. Log on to the Avaya Experience Portal Linux server in one of the following ways:

• Log in locally as a user with root privilege or as a user who belongs to the susers group.

• Log in remotely as a non-root user, and then enter the su - command to change the 
user to a user with root privileges or a user who belongs to the susers group.

2. Navigate to the $AVAYA_HOME/Support/Security-Tools/EASG directory where the 
script is located.

3. Run the bash EASGConfigure.sh --disable command.

The script displays the Acceptance of terms prompt for disabling EASG.

For example:
bash EASGConfigure.sh --disable
Invocation at Tue Apr 25 16:39:51 PDT 2017
LOG FILE: /opt/Avaya/ExperiencePortal/logs/EASGConfigure/
EASGConfigure.sh.2017-04-25.log
Enhanced Access Security Gateway (EASG)
EASG is enabled
By disabling Avaya Services Logins you are denying Avaya access to your system. 
This is not recommended, as it can impact 
Avaya's ability to provide support for the product. Unless the customer is well 
versed in managing the product themselves, 
Avaya Services Logins should not be disabled.

4. Enter one of the following:

• yes to accept the EASG terms.

• no to cancel.

5. Review the output and debug log from the /opt/Avaya/ExperiencePortal/logs/
EASGConfigure directory to ensure that the script completes successfully.

Displaying EASG status
About this task
Use the EASGConfigure.sh script to display the current EASG state on an Avaya Experience 
Portal server. The current EASG state can be enabled or disabled.
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Before you begin
If the current EASG state of the Avaya Experience Portal server is disabled, you cannot log into 
the Experience Portal server with any Avaya Services Login accounts. Ensure that the server has 
a non-Avaya service account with root privilege or a user who belongs to the susers group to run 
the EASGConfigure.sh script.

Procedure
1. Log on to the Avaya Experience Portal Linux server in one of the following ways:

• Log in locally as a user with root privilege or as a user who belongs to the susers group.

• Log in remotely as a non-root user, and enter the su - command to change the user to 
a user with root privileges or a user who belongs to the susers group.

2. Navigate to the $AVAYA_HOME/Support/Security-Tools/EASG directory where the 
script is located.

3. Run one of the following commands:

• bash EASGConfigure.sh
• bash EASGConfigure.sh --status

The script shows the current EASG state.

EASG built-in utilities
Note:

You must always use the Avaya Experience Portal wrapper script EASGConfigure.sh to 
enable or disable EASG.

EASGProductCert
The EASGProductCert script is available to all users by default.  It has two modes of operation:

• The script can print details about the product certificate.
• The script can check for product certificate expiration.

The following is an example of the EASGProductCert command-line arguments usage:
EASGProductCert --lessThanDays <number_of_days>
EASGProductCert --certInfo
Where:
--lessThanDays:
Determines if the certificate will expire within the number of days indicated by 
<number_of_days>.  A return code of 1 indicates
 that the EASG Product Certificate will expire within <number_of_days>. A return code 
of 0 indicates that the EASG Product 
Certificate will not expire in <number_of_days>.  Finally, if an error is encountered, 
a return code of 2 is issued.
--certInfo:
Display information about the EASG Product Certificate.

The following is an example of running EASGProductCert with --certInfo:
EASGProductCert --certInfo
Subject: CN=Avaya Experience Portal  3.1, OU=EASG, O=Avaya Inc.
Serial Number: 10001
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Expiration: Jul 27 04:00:00 2031 GMT
Trust Chain:
1. O=Avaya, OU=IT, CN=AvayaITrootCA2
2. DC=com, DC=avaya, DC=global, CN=AvayaITserverCA2
3. O=Avaya Inc, OU=EASG, CN=EASG Intermediate CA
4. CN=Product EASG Intermediate CA, OU=EASG, O=Avaya Inc.
5. CN=Avaya Experience Portal  8.1, OU=EASG, O=Avaya Inc.

EASG Status
The EASGStatus script is available to all users by default. It shows the current the EASG state as 
enabled or disabled.

EASGSiteCertManage
The EASGSiteCertManage is restricted to root access or users who belong to the susers group. 
Users who belong to the susers group can use the sudo EASGSiteCertManage command to 
run the script. On-site technicians who do not have access to Avaya network primarily use the site 
certificates when they are on the customer’s premises. The EASGSiteCertManage command 
can be run with no options to get documentation about its usage.

EASG Challenge-Response Authentication
EASG challenge generation
When EASG is enabled, an attempt to access the product via an Avaya Service Login results in 
providing the following information:

• Challenge String: The new EASG Challenge String is the legacy ASG challenge format with 
the Product Certificate ID appended at the front. The Product Certificate ID is the serial 
number of the Avaya Experience Portal product certificate.

• Product ID String: The new Product ID string is a globally unique identifier (GUID) that the 
EASG RPM generates, with the EASG RPM version number appended at the end.

The following is an example of the challenge and Product ID when using the Avaya service 
account to access the system:
Challenge: 10001-85132972        
Product ID: 09f2c551f32e4c808b7fd3c544365a8f01
Response:
EASG response generation
The Avaya EASG Web Mobile interface is enhanced to accept all the existing inputs for ASG and 
EASG challenges. Avaya EASG Web Mobile then provides this information to the Avaya EASG 
backend server and shows the appropriate responses to the user.
The new EASG response strings can reach up to a maximum of 512 bytes strings. There is a 
Copy Response to Clipboard button on the Avaya EASG Web Mobile web page, which the user 
can use to copy the response string and paste it to the Linux login shell.

EASG response validation
If an EASG Response is not submitted to the product within five minutes of the EASG Challenge 
String being provided, the challenge expires. Any EASG response submitted against an expired 
challenge fails validation and the login fails.
If the EASG Response validation succeeds, then the Avaya service account user can access the 
system with the permissions associated with the Avaya Service Login name. The Linux system 
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log /var/log/messages records an authentication through the success message of the product 
certificate.
If the EASG Response validation fails, the user is denied access to the system, and the 
challenge is depreciated. Any subsequent login attempt needs a new challenge. The Linux system 
log /var/log/messages records an authentication failed message.

EASG site certificate management
Avaya technicians use the EASG site certificate when they do not have access to the Avaya 
network to generate responses. The technicians use the EASG site manager tool to generate 
the EASG site certificate. After the technician successfully generates the EASG site certificate, 
the technician sends the certificate to the customer with instructions on how to install the site 
certificate.

Note:

The EASG site manager tool uses version 7 and later.

Generating a site certificate
About this task
Use this procedure to generate a site certificate on the EASG site manager tool. The EASG site 
manager tool can only issue a single valid site certificate for one technician at a time. A new site 
certificate request overwrites any previously valid site certificate if it exists.

Note:
The EASG site certificate expires 2 weeks from the date of creation.

Procedure
1. On the EASG site Manager tool, click the EASG Site Cert tab.

2. Click New to generate a new EASG site certificate.

After you successfully generate the site certificate, you see a message at the bottom of the 
EASG site Manager window. The message shows for how long the site certificate is valid 
and where it is located.

Installing the site certificate
About this task
Use this procedure to install the EASG site certificate on the Avaya Experience Portal server.
The Linux system log /var/log/messages records a successful site certificate installation 
message.

Procedure
1. Log on to the Avaya Experience Portal Linux server in one of the following ways:

• Log in locally as a user with root privilege or as a user who belongs to the susers group.

• Log in remotely as a non-root user, and enter the su - command to change the user to 
a user with root privileges or a user who belongs to the susers group.
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2. Upload the site certificate to the Avaya Experience Portal Linux server.

3. Run the EASG built-in tool EASGSiteCertManage to install the uploaded site certificate.

4. Run the following command:

(sudo) EASGSiteCertManage --add <filename> --saf <SAF>
Where,

• sudo: If the user who runs the command belongs to the susers group, the user must 
add sudo in front of EASGSiteCertManage. If the user is a root privilege user, there is 
no need to add sudo.

• filename: The location of the site certificate.

• SAF: The Site Authentication Factor code is a 10 to 20-character alphanumeric string. 
The SAF is required for technician access when the technician generates a response.

For example:
[root@EP72PRI voiceportal]# EASGSiteCertManage --add 
/home/voiceportal/test.p7b --saf 1234567890
Site Certificate installed successfully.

Displaying the site certificate content
About this task
Use this procedure to display all the installed EASG site certificates on the Avaya Experience 
Portal server and the content of an installed EASG site certificate.

Procedure
1. Log on to the Avaya Experience Portal Linux server in one of the following ways:

• Log in locally as a user with root privilege or as a user who belongs to the susers group.

• Log in remotely as a non-root user, and enter the su - command to change the user to 
a user with root privileges or a user who belongs to the susers group.

2. To display a list of installed site certificates, run the following command:

(sudo) EASGSiteCertManage --list
If the user who runs the command belongs to the susers group, the user must add sudo in 
front of EASGSiteCertManage. If the user is a root privilege user, there is no need to add 
sudo.

For example:
[root@EASG voiceportal]# EASGSiteCertManage --list
Valid Site Certificates:
  1. test.p7b

3. To display the content of a site certificate, run the following command:

(sudo) EASGSiteCertManage --show <SiteCertName>

Configuration

November 2024 Deploying Experience Portal in an Avaya Customer Experience Virtualized Environment 50
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingExperiencePortalinanAvayaCustomerExperienceVirtualizedEnvironment&p3=13


Where,

• sudo: If the user who runs the command belongs to the susers group, the user must 
add sudo in front of EASGSiteCertManage. If the user is a root privilege user, there is 
no need to add sudo.

• SiteCertName: The name of the site certificate.

For example:
[root@EASG voiceportal]# EASGSiteCertManage --show test.p7b

Subject: CN=Avaya Technician test, OU=EASG, O=Avaya Inc.
User Name: test
Expiration: Feb 16 00:51:39 2017 GMT
Trust Chain:
1. O=Avaya, OU=IT, CN=AvayaITrootCA2
2. DC=com, DC=avaya, DC=global, CN=AvayaITserverCA2
3. O=Avaya Inc, OU=EASG, CN=EASG Intermediate CA
4. CN=Site EASG Intermediate CA, OU=EASG, O=Avaya Inc.
5. CN=Avaya Technician dchen, OU=EASG, O=Avaya Inc.

Deleting a site certificate
About this task
The Avaya Experience Portal system automatically deletes expired EASG site certificates. Use 
this procedure to manually delete the installed EASG site certificate.
The Linux system log /var/log/messages records a site certificate deletion message.

Procedure
1. Log on to the Avaya Experience Portal Linux server in one of the following ways:

• Log in locally as a user with root privilege or as a user who belongs to the susers group.

• Log in remotely as a non-root user, and enter the su - command to change the user to 
a user with root privileges or a user who belongs to the susers group.

2. Run the following command:

(sudo) EASGSiteCertManage --delete <SiteCertName>
Where,

• sudo: If the user who runs this command belongs to the susers group, the user must 
add sudo in front of EASGSiteCertManage. If the user is a root privilege user, there is 
no need to add sudo.

• SiteCertName: The name of the site certificate.

For example:
[root@EASG voiceportal]# EASGSiteCertManage --delete test.p7b
Successfully removed Site Cert: test.p7b
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Generating a site certificate response
About this task
Use this procedure to generate a site certificate response on the EASG site Manager tool.

Procedure
1. Log in to the Avaya Experience Portal system using one of the Avaya Service Logins.

The login shell displays the Challenge and Product ID.

2. On the EASG site Manager tool, click the Authenticate tab.

3. Select EASG (Certificate Based Authentication) and click OK.

You see the EASG Authentication window.

4. Enter the appropriate information in the fields.

5. Click Generate Response to create the response.

6. Click Copy Response to copy the response to the computer clipboard.

7. Paste the response into the login shell.

The login is successful.

The Linux system log /var/log/messages records an authentication through the site 
certificate success message.

EASG Authentication field descriptions

Name Description
Equipment The Product ID displayed in the login shell.

When you log in to the Avaya Experience Portal 
system using one of the Avaya Service Logins, you 
can see the Product ID in the login shell.

EquipLogin The Avaya Service Login accounts (init, inads, craft, 
or sroot).

SAF PIN The SAF code that the customer enters when the 
site certificate is installed.

Challenge The Challenge displayed in the login shell.

When you log in to the Avaya Experience Portal 
system using one of the Avaya Service Logins, you 
can see the Challenge in the login shell.

Response The response displayed when you click Generate 
Response.
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Logging in to the Experience Portal web interface
About this task
The Experience Portal Manager (EPM) web interface is the main interface of the Experience 
Portal system.

Procedure
1. Open a compatible web browser and type http://<EPM-server>//VoicePortal (useinput).
2. In the User Name field, enter the EPM web interface username value that was entered 

during the Primary EPM OVA deployment.

3. Click Submit.
4. In the Password field, enter the EPM web interface password value that was entered 

during the Primary EPM OVA deployment.

5. Click Logon.

You are now logged into the Experience Portal web interface.

Installing the license file
You require a license file for the Experience Portal operation. The license file defines all features 
that you are authorized to use. Avaya sends the Experience Portal license file separately in an 
email message.

About this task
If you do not receive a license file from Avaya, contact your Avaya representative or Avaya Partner 
representative.

Note:
In Experience Portal, you can activate the WebLM license server on the Primary EPM OVA.

Before you begin
Important:
If a Standalone WebLM is being used, you must install the WebLM trusted certificates on the 
EPM. For more information on installing trusted certificates for secure communications with 
standalone Avaya WebLM, see Administering Avaya Experience Portal.

Procedure
1. Open the email message that contains the Experience Portal license file.

2. Detach the license file from the email message and store the license file on a computer 
that can access the Experience Portal servers from a network connection.

You can install the license file on any server from which you can gain access to the EPM 
web interface.

3. Log on to the EPM web interface by using an account with the Administration user role.
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4. From the EPM main menu, select Security > Licensing.

The Licensing page displays the license information and the location of the License server.

5. Type the URL of the license server in the License Server URL field.

The URL must be in the format https://WebLM-machine:port_num/WebLM/
LicenseServer, where:

• Weblm-machine is the hostname or IP address of the WebLM server.

• :port_num is an optional parameter that consists of a colon followed by the port 
number for the WebLM server. If WebLM uses the default configuration, specify 52233.

6. Click Verify.

The browser opens a separate window and displays the Avaya WebLM page, which 
contains a License Administration link.

7. Click License Administration.

The system displays the Web License Manager Logon page.

8. If you have done a fresh installation of the WebLM server, do the following:

a. Enter the default user name admin.

b. Enter the default password weblmadmin.

c. Press Enter or click the arrow button to log in.

d. Enter the details on the Change Password page. Ensure that you type weblmadmin 
in the Current Password field.

e. Click Submit.
f. On the Logon page, log in with your new password.

9. If you have an existing WebLM server, you have to do the following:

a. Type the user name.

b. Type the password.

c. Click Continue.

10. On the Install License page, click Browse to locate the Experience Portal license file.

11. Select the license file, accept the WebLM license, and then click Install.

WebLM uploads the license file from your computer to the WebLM server and displays the 
message License file installed successfully.

12. Log out of the Web License Manager, and close the Web License Manager page.

13. On the EPM Licensing page, click Apply.

14. Click OK to confirm the change.

15. Verify that the new licensing information is correct.
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Importing server identity certificates
For more information on importing the following identity certificates, see Administering Avaya 
Experience Portal.

• Primary EPM server identity certificate

• Auxiliary EPM server identity certificate

• MPP server identity certificate

• Single server identity certificate

Configuring the primary EPM server to support one or more 
auxiliary EPM servers

About this task
You must configure the vpcommon PostgreSQL database user account on the Primary EPM 
server before you can add the Auxiliary server to the EPM.

Procedure
1. Log in to Linux on the primary EPM server.

If you are an Avaya Services representative, and use Avaya Enterprise Linux, the 
Avaya Service accounts will not be available after the Avaya Enterprise Linux upgrade. 
The Avaya Service accounts will be available through EASG configuration during the 
Experience Portal upgrade.

• Log on to the local Linux console as root.

• Or log on remotely as a non-root user and then change the user to root by entering the 
su - root command.

2. Navigate to the Support/Security-Tools directory by running the cd $AVAYA_HOME/
Support/Security-Tools command.

3. Enter ./SetDbPassword.sh add_primary_vpcommon.

The system prompts you to enter a password.

4. Enter a new password that you want to use for the vpcommon user account.

The script prompts if you want to restart the services. If you select Y then the script will 
restart them automatically.

Note:

If the MS SQL database is customer provided database, then customer needs to 
manage the administration and support of the system and contents of the database.

Next steps
1. Configure the vpcommon PostgreSQL database user account on the auxiliary EPM server.
2. Add the auxiliary EPM server to Experience Portal Manager.

Configuring and initializing the Experience Portal system

November 2024 Deploying Experience Portal in an Avaya Customer Experience Virtualized Environment 55
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingExperiencePortalinanAvayaCustomerExperienceVirtualizedEnvironment&p3=13


Configuring a password for database user vpcommon on an 
auxiliary EPM server

About this task
Before you add an auxiliary EPM to the primary EPM, you must configure the vpcommon 
PostgreSQL database user account on the auxiliary EPM server.

Procedure
1. Log in to Linux on the auxiliary EPM server.

2. Navigate to the Support/Security-Tools directory by entering the cd 
$AVAYA_HOME/Support/Security-Tools command.

3. Enter the ./SetDbPassword.sh update_primary_vpcommon command to update 
the vpcommon user account.

The system prompts you to enter the password that you have assigned to the vpcommon 
user account on the primary EPM server.

4. Enter the vpcommon password.

The script now prompts if you want to restart the services, if you select Y then the script 
will restart them automatically.

5. Restart the PostgreSQL service by entering the service postgresql restart 
command.

6. Restart the vpms service by entering the service vpms restart command.

7. Restart the mmsserver service by entering the service mmsserver restart 
command.

Next steps
Add the auxiliary EPM server to Experience Portal Manager.

Changing the time zone on Avaya Linux
About this task
Use this procedure to change the time zone on the EPM or VPMS server.
For more information on changing the time zone from the command line, see https://
access.redhat.com/solutions/1449713.

Procedure
1. Log in to the Avaya Linux server.

2. Change to the root user account.

For example, run this command: su root.

3. Navigate to the /usr/share/zoneinfo/ directory on Avaya Linux and locate the time 
zone that you want to configure.
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The directory structure contains the names and time zones for different regions of the 
world. For example, the /usr/share/zoneinfo/Europe directory contains a Dublin 
time zone file with a time zone value: “Europe/Dublin”.

4. If the virtual machine BIOS has the Universal Time Coordinated (UTC) set as true, enable 
UTC while setting the time zone on Avaya Linux. The UTC in the Linux configuration file 
must match the BIOS settings.

Validate if the system BIOS or Hardware clock is using UTC time by running this 
command: hwclock --verbose.

If UTC is enabled, you will see this line:
Hardware clock is on UTC time

5. Create a backup copy of the /etc/sysconfig/clock file.

For example, to create a backup copy called clockORIG, run the command:

cp –p /etc/sysconfig/clock /etc/sysconfig/clockORIG

Note:

If the file is not present in the file system, create the /etc/sysconfig/clock file 
with 0644 permissions and the current zone.

6. Using the root user account, open the /etc/sysconfig/clock file and edit the zone.

If applicable, set the UTC value to true or false to match the BIOS settings.

For example, run the following commands to change to the Dublin time zone:

ZONE=”Europe/Dublin”
UTC=true

7. Save the changes in the updated /etc/sysconfig/clock file.

8. Do the following to update the time zone data on the system:

a. To find the desired time zone, run one of the following commands:

• tzselect
• timedatectl list-timezones

b. Change the time zone by running the following command:

For example, timedatectl set-timezone Europe/Dublin
c. Verify the status of the time zone by running the following command:

timedatectl status
9. If the system is an EPM, restart the vpms service by running this command: /sbin/

service vpms restart
10. Log on to the Avaya Experience Portal web console and navigate to Home > System 

Configuration > Zones.

Configuring and initializing the Experience Portal system

November 2024 Deploying Experience Portal in an Avaya Customer Experience Virtualized Environment 57
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingExperiencePortalinanAvayaCustomerExperienceVirtualizedEnvironment&p3=13


11. Click Default and select the new time zone from the list.

For example, select (GMT+00:00) Europe/Dublin from the list.

12. Click Apply and then click Save.

Configuration
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Chapter 6: Post-deployment verification 
and testing

Adding the Experience Portal test application
About this task
You can use the sample application that is installed with Experience Portal to test how the system 
handles telephony resource requests.

• If you run the sample application as a VoiceXML application, Experience Portal uses the 
default CCXML page installed on the MPP server to provide basic CCXML controls. The 
VoiceXML application tests:
- ASR resources
- TTS resources
- Bridge transfers
- Blind transfers
- Supervised transfers
- Several audio prompt formats
- Audio prompt recording and playback

• If you run the sample application as a CCXML application, Experience Portal uses a more 
advanced CCXML page that provides all the functionality of the VoiceXML application and 
you can test the following CCXML features:
- Call conferencing
- Call classification
- Call merge for calls using a SIP connection

Before you begin
If you want to test Automatic Speech Recognition (ASR) resources, ensure that you add one or 
more ASR servers to the Experience Portal system.
If you want to test Text-to-Speech (TTS) resources, ensure that you add one or more TTS servers 
to the Experience Portal system.

Procedure
1. From the EPM main menu, select System Configuration > Applications.
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2. On the Applications page, click Add.

EPM displays the Add Application page.

3. In the Name field, type the name you want to use to identify the application on the system. 
After you save the application, this name cannot be changed.

For example, type Test_App.

4. Enter the required parameters for the application.

The following table provides information on the parameters that you must enter for each 
application type.

Application type Required parameters
VoiceXML 
application

In the Type field, select VoiceXML.

In the VoiceXML URL field, type http://MPP_Identifier/mpp/misc/
avptestapp/intro.vxml, where MPP_Identifier is the hostname or 
IP address of any one of the MPP servers in the Experience Portal system.

CCXML application In the Type field, select CCXML.

In the CCXML URL field, type http://MPP_Identifier/mpp/misc/
avptestapp/root.ccxml, where MPP_Identifier is the hostname or 
IP address of any one of the MPP servers in the Experience Portal system.

5. Click Verify to make sure that the system can locate the sample application page.

If EPM can find the specified page, EPM displays the page in a separate browser window. 
If this check succeeds, continue with this procedure. Otherwise, correct the information in 
the VoiceXML URL or CCXML URL field and repeat this step until the system can locate 
the sample application page.

Note:

Instead of opening the file in a separate window, the browser might prompt you to save 
the file as a text file. You can choose to save the file and use text editor to open the 
file.

6. If you want to test ASR resources, complete the following steps:

a. Select the type of ASR server you want to use from the ASR drop-down list.

b. From the Languages list, select English(US) en-us.

7. If you want to test TTS, complete the following steps:

a. Select the type of TTS server you want to use from the TTS drop-down list.

b. From the Voices list, select one or more of the English(US) voices.

8. To associate one or more incoming numbers with this application, enter the appropriate 
information in the Application Launch group.

9. To test transcriptions, go to the Transcription section of the Reporting Parameters group 
and set the transcription parameters.

Post-deployment verification and testing
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Note:

You can set the transcription parameters only if you have the Privacy Manager user 
role.

10. Click Save.

EPM displays the Applications page with the test application listed in the table.

Running the sample application
Procedure

1. Call the test application number.

The test application number is the number that you specify when you add the test 
application to the Experience Portal system.

2. If you run the test application as a VoiceXML application, press:

• 1 for Automatic Speech Recognition (ASR)

• 2 for Text-to-Speech (TTS)

• 3 for Bridge Transfer

• 4 for Blind Transfer

• 5 for Consultative Transfer

• 6 for Audio test

• 7 to Exit

3. If you run the test application as a CCXML application, press:

• 1 for Automatic Speech Recognition (ASR)

• 2 for Text-to-Speech (TTS)

• 3 for Bridge Transfer

• 4 for Blind Transfer

• 5 for Consultative Transfer

• 6 for Audio test

• 7 to test Conferencing

• 8 to test Merge

• 9 to test Call Classification

• 0 to Exit

Running the sample application
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Next steps
After you run the application, you can create reports to verify the application's performance and, if 
you have enabled transcriptions, view the transcription data.

Test Application result for Call Classification option
When you run the test application as a CCXML application, and press 9 to test call classification, 
the application plays the following prompts based on the call status:

Call Status Prompt
Line is busy The busy tone is detected.
Invalid number is 
detected

Fail to create call.

Call is connected and 
human voice is heard

Detected live voice.

Call is connected and 
a recorded message is 
detected

Detected answering machine.

Call is connected and 
fax is detected

Detected fax.

Call is connected and 
sit tone is detected

The sit tone is detected.

Trunks are busy The fast busy tone is detected.
Call classification 
detection does not 
detect anything within 
the specified timeout 
period

Timeout is detected.

Error occurs during call 
classification detection

Error occurs while detecting.

Call is not answered No answer is detected.

Test Application result for Call Conferencing option
When you run the test application as a CCXML application, and press 7 to test call conferencing, 
the application plays the following prompts based on the call status:

Call Status Prompt
Call to destination fails Fail to create call.
Call is successful Thank you.

Note:

When the call conference is successful, the application plays additional 
prompts.

For H323, enter 9 with the phone number. Otherwise, the call fails.

Post-deployment verification and testing
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Test Application result for Call Merge option
When you run the test application as a CCXML application, and press 8 to test call merging, the 
application plays the following prompts based on the call status:

Call Status Prompt
The application detects 
H.323 connection

This option is not supported in H.323. Please use SIP.

Merge is successful. Thank you.

Note:

After playing the thank you prompt, the application merges the call.

This option is not supported for H.323.

Configure and run the Application Interface test client
Use the Application Interface test client to validate the Application Interface web service and 
the Experience Portal outcall functionality. The Application Interface test client is available in 
$AVAYA_HOME/Support/OutCallTest/VPAppIntfClient.

Configuring Experience Portal for outcall
About this task

Important:
This configuration is required only if you use Experience Portal to perform outcalls or the 
Application Interface web service to launch VXML and CCXML applications.

Procedure
1. Ensure that at least one of the ports in the system is configured to allow outbound calls. 

For more information on configuring ports, see Administering Avaya Experience Portal.

2. The VPAppIntfService Web service version authenticates users that are configured as 
Experience Portal users. The user must have the Web Services role.

Running the Application Interface test client VPAppIntfClient.sh
About this task
Use this procedure to run the Application Interface test client VPAppIntfClient.sh, and verify if 
the Application Interface test client shows the total and unused ports available for outcalls, and the 
result of the LaunchVXML operation.

Configure and run the Application Interface test client
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Note:
If FIPS is enabled on the system where VPAppIntfClient.sh is being launched, you need 
to specify the following additional command line arguments:

• -K <Java Truststore>: The Java truststore file name including the path which 
contains all the trusted certificates. If the command is running on Primary EPM, the 
Primary EPM truststore can be specified using the value EPM_TRUSTSTORE.

• -O <Java Truststore password>: The password for the Java truststore file. If the 
command is running on Primary EPM, the Primary EPM truststore password can be 
specified using the value EPM_TRUSTSTORE_PASS

Before you begin
Ensure that you configure Avaya Experience Portal for the Application Interface test client as 
described in Configuring Experience Portal for outcall on page 63.

Procedure
1. Log on to Linux on the Experience Portal server.

If you are an Avaya Services representative, and use Avaya Enterprise Linux, the 
Avaya Service accounts will not be available after the Avaya Enterprise Linux upgrade. 
The Avaya Service accounts will be available through EASG configuration during the 
Experience Portal upgrade.

• Log on to the local Linux console as root.

• Or log on remotely as a non-root user and then change the user to root by entering the 
su - root command.

2. Navigate to the Application Interface test client directory by entering the cd 
$AVAYA_HOME/Support/OutCallTest/VPAppIntfClient command.

3. Use the following examples to show calling Application Interface test client using different 
authentication schemes:

a. Password Authentication

Enter the ./VPAppIntfClient.sh —n <outcall-username> —p <outcall 
password> command to request the number of available outbound ports.

• <outcall-username> is an Experience Portal user configured on the Users page of 
the EPM web interface..

• <outcall password> is the password for <outcall-username> that is configured on 
the Users page of the EPM web interface.

Note:

The user must have the Web Services user role.

b. Certificate Authentication
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Enter the ./VPAppIntfClient.sh -y certificate -k <Java Keystore> 
—o <Java Keystore password> command to request the number of available 
outbound ports.

• -y: <certificate> the authentication type is certificate.

• -k: <Java Keystore> the Java keystore file name including the path. The Java 
keystore should contain the User identity certificate including the private key.

• -o: <Java Keystore password> the password for the Java keystore file.

Note:

Import the User identity certificate to the EPM and ensure that the certificate is 
assigned to a user of Certificate type.

The user must have the Web Services user role.

c. Password and Certificate Authentication

Enter the ./VPAppIntfClient.sh -n <outcall-username> -p <outcall 
password> -y password+certificate -k <Java Keystore> —o <Java 
Keystore password> command to request the number of available outbound ports.

• <outcall-username> is an Experience Portaluser configured on the Users page of 
the EPM web interface..

• <outcall password> is the password for <outcall-username> that is configured on 
the Users page of the EPM web interface..

• -y: <password+certificate> the authentication type is password and certificate.

• -k: <Java Keystore> the Java keystore file name including the path. The Java 
keystore should contain the User identity certificate including the private key.

• -o: <Java Keystore password> the password for the Java keystore file.

Note:

Import the User identity certificate to the EPM and ensure that the certificate is 
assigned to the <outcall-username> and the user authentication type is Password 
and Certificate.

The user must have the Web Services user role.

4. Verify that the Application Interface test client displays a response that shows the total 
ports and unused ports available for outcalls.

For example:

Mon Jun 03 16:55:26 PDT 2017:VPAppIntfServiceClient: queryResources 
succeeded, Total Resources = 0, Unused H323 = 0, Unused SIP = 0
Mon Jun 03 16:55:26 PDT 2017: VPAppIntfServiceClient: exiting

Configure and run the Application Interface test client
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5. Use the following examples to show calling Application Interface test client using different 
authentication schemes.

a. Password Authentication

Enter the ./VPAppIntfClient.sh -R 1 -A <application-name> 
-T <number-to-dial> -n <outcall-username> -p <outcall 
password>  command to initiate an outcall and launch a VoiceXML application.

• <application-name> is the name of the application that you specify on the 
application page.

• <number-to-dial> is the phone number to place the outcall to.

• <outcall-username> is the Experience Portal username configured with the Web 
Services role on the Users page of the EPM web interface..

• <outcall password> is the password assigned to the outcall-username above that 
was configured on the Users page of the EPM web interface.

Note:

The user must have the Web Services user role.

b. Certificate Authentication

Enter the ./VPAppIntfClient.sh -R 1 -A <application-name> -T 
<number-to-dial> -y certificate -k <Java Keystore> —o <Java 
Keystore password> command to initiate an outcall and launch a VoiceXML 
application.

• <application-name> is the name of the application that you specify on the 
application page.

• <number-to-dial> is the phone number to place the outcall to.

• -y: <certificate> the authentication type is certificate.

• -k: <Java Keystore> the Java keystore file name including the path. The Java 
keystore should contain the User identity certificate including the private key.

• -o: <Java Keystore password> the password for the Java keystore file.

Note:

Import the User identity certificate to the EPM. Ensure that the certificate is 
assigned to the user of Certificate type.

The user must have the Web Services user role.

c. Password and Certificate Authentication

Enter the ./VPAppIntfClient.sh -R 1 -A <application-name> -T 
<number-to-dial> -n <outcall-username> -p <outcall password> -
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y password+certificate -k <Java Keystore> —o <Java Keystore 
password>command to initiate an outcall and launch a VoiceXML application, where:

• <application-name> is the name of the application that you specify on the 
application page.

• <number-to-dial> is the phone number to place the outcall to.

• <outcall-username> is the Experience Portal user name configured from EPM Web 
interface.

• <outcall password> is the password for <outcall-username> that is configured from 
the EPM Web interface.

• -y: <password+certificate> the authentication type is password + certificate.

• -k: <Java Keystore> the Java keystore file name including the path. The Java 
keystore should contain the User identity certificate including the private key.

• -o: <Java Keystore password> the password for the Java keystore file.

Note:

Import the User identity certificate to the EPM, ensure that the certificate is 
assigned <outcall-username>, and the user authentication type is Password and 
Certificate.

The user must have the Web Services user role.

6. Verify that the dialed phone number rings.

7. Answer the phone and verify that the specified application handles the call.

Note:

The application handles the call in the same way as when an actual user calls into the 
system.

8. Verify that the Application Interface test client displays the following:

• A response that shows the result of the LaunchVXML operation.

• The total ports and the unused ports available for outcalls.

For example:

Mon Jun 03 17:00:31 PDT 2017: VPAppIntfServiceClient: launchVXML succeeded, 
SessionID = scaaep134-2013155001030-5, TotalRes = 100, UnusedH323 = 0, UnusedSIP 
= 99

Mon Jun 03 17:00:31 PDT 2017: VPAppIntfServiceClient: exiting

Configure and run the Application Interface test client
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Chapter 7: Upgrading Experience Portal

Upgrade overview
This chapter describes the procedures to upgrade Experience Portal in the virtualized 
environment. To upgrade existing Experience Portal OVA-based systems to Experience Portal 
8.x, you can do one of the following:

• Deploy new virtual machines and restore the existing data. This is the traditional upgrade 
method and described in detail in this chapter.

• Perform an in-place upgrade of the Experience Portal software. This method is described in 
Upgrading to Avaya Experience Portal.

The in-place upgrade procedure is similar to the upgrade of physical bundled systems. It uses 
the vpupgrade.sh script to upgrade Avaya Linux, if applicable, and the autoupgradevp script 
to upgrade Experience Portal.Avaya Linux is upgraded during the in-place upgrade. The VMware 
tools will also be automatically updated to VMwareTools-10.0.0-3000743.

Note:

The VM properties in the VMWare Client VM Summary tab are set during the OVA build. The 
system will not update these properties, if you perform the upgrade using the ISO image or 
the Experience Portal media. You must get the Experience Portal version either by using the 
iaversion.php or through Experience Portal Manager.

Upgrading Primary EPM
Before you begin
If you have a new license file, upgrade the license.

Procedure
1. Create a backup of the Experience Portal system by using the System Backup Web page 

in EPM. .

For more information about backing up an Experience Portal system from the System 
Backup menu in EPM, see Administering Avaya Experience Portal.

Before you proceed, take the backup of the virtual machine.
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2. Shut down the Experience Portal virtual machine.

Note:

If you want to restore the Experience Portal virtual machine later, you do not need to 
delete the virtual machine. Keeping the virtual machine in its shut-down state enables 
you to restore the machine if required.

3. Deploy the new Primary EPM OVA on a new virtual machine.

Important:

During the deployment process, give the new Experience Portal virtual machine the 
same network configuration, including IP address and hostname, as the old virtual 
machine.

4. Restore the backup on the new Experience Portal virtual machine using command line 
interface.

For more information about restoring data backed up from the System Backup menu in 
EPM, see Administering Avaya Experience Portal

5. Restart the new Experience Portal virtual machine.

6. Reconfigure the Avaya Service accounts.

For more information about re-configuring the Avaya Service accounts, see Upgrading to 
Avaya Experience Portal 8.1.

7. Run the setup_vpms.php command on the MPP server to authorize the security 
certificate so that the MPPs running on a previous version are functional with the upgraded 
EPM.

8. Trust the new security certificate for the MPP from the System Configuration > MPP 
Servers > Change MPP Server page.

9. Repeat steps 2 and 3 for each additional MPP in the system.

On upgrading the Primary EPM OVA, the co-resident MPP resets to the disabled state. 
You must re-enable the co-resident MPP.

For more information about reconfiguring the Avaya Service accounts, see Upgrading to 
Avaya Experience Portal 8.1.

Upgrading Auxiliary EPM
Procedure

1. Shut down the Auxiliary EPM virtual machine.

2. Deploy the Auxiliary EPM OVA on a new virtual machine.

Upgrading Auxiliary EPM
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Important:

During the deployment process, give the new Experience Portal virtual machine the 
same network configuration, including IP address and hostname, as the old virtual 
machine.

3. Configure the password of the vpcommon user that you created during the Primary EPM 
upgrade. 

For more information about configuring the vpcommon password, see Configuring 
password for database user vpcommon on an auxiliary EPM on page 56.

4. Log on to the EPM Web interface.

5. To trust the new security certificate for the Auxiliary, click System Configuration > EPM 
Servers > Change EPM Server.

Next steps
(Optional) Delete the old Auxiliary EPM VM once you confirm the new Auxiliary EPM to be working 
and functional.

Upgrading MPP
Before you begin
If your system has more than one MPP, you can upgrade one MPP at a time to allow the other 
MPPs to function with the upgraded EPM.

Procedure
1. Log on to the EPM Web interface.

2. To stop the MPP server, click System Management > MPP Manager.
3. Schedule a report data download from the Report Data pagepage in EPM so that EPM 

collects the calls records from the MPP servers.

4. When the report download is complete, click System Management > MPP Manager .
5. When the MPP is offline, shut down the MPP virtual machine.

6. Deploy the MPP OVA on a new virtual machine.

Important:

During the deployment process, give the new Experience Portal virtual machine the 
same network configuration, including IP address and hostname, as the old virtual 
machine.

7. Log on to the EPM Web interface.

8. To trust the new security certificate for the MPP, click System Configuration > MPP 
Servers > Change MPP Server .

Upgrading Experience Portal
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9. To change the MPP status to the online mode, click System Management > MPP 
Manager .

10. To start the MPP server, click System Management > MPP Manager .
Next steps
(Optional) Delete the MPP once you confirm the new MPP to be working and functional.

Upgrading MPP
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Chapter 8: Best practices for VMware 
vSphere

Best practices for VMware vSphere

VM Snapshots
The following are the best practices specific to Experience Portal:

• Experience Portal is a real-time application. Ensure that Experience Portal is not running 
when you take a snapshot or revert to a snapshot.

• To prevent the side effects, shut down the virtual machine when you take or revert to a 
snapshot. Otherwise, the running systems may experience side effects such as dropped 
calls, web sessions, and servers out of sync.

• If you take a snapshot of a live EPM virtual machine, and revert the snapshot, you must 
restart the EPM service from the command line to resynchronize the Experience Portal 
environment.

Note:
Log in to the console as sroot and run the service vpms restart command.

• If you take a snapshot of a live MPP virtual machine, and revert the snapshot, you must 
restart the MPP to re-synchronize the system.

Note:
Restart the MPP from the System Management > MPP Manager page in EPM.

• After reverting a snapshot, and when the system is running, ensure that you delete all 
snapshots for the virtual machine in Snapshot Manager. The overhead of running with 
snapshots can impact the system performance, especially with disk I/O.

• For more information, see best practices for using virtual machine snapshots in the vSphere 
environment article in the VMware knowledge base.

High Availability
High Availability (HA) is an option for Experience Portal to restart critical systems in the case of an 
ESXi host failure or general failure with the virtual machine.
Virtual servers running on a failed ESXi host experiences downtime until the virtual servers starts 
on another host in the HA cluster. The downtime is the time to detect the failure plus the time for 
the virtual machine to power on and startup.
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VMware recommends using a secondary NIC for the management network when configuring HA, 
although it is not required.
The following are the recommended configuration to set up an HA cluster to be used with 
Experience Portal virtual machines:

• Each MPP must be configured with Restart Automatically set to Yes in EPM. To check the 
MPP setting, go to EPM > System Configuration > MPP Servers and click the MPP server 
name.

• Enable the HA cluster feature by checking Turn On vSphere HA.
• Go to vSphere HA cluster settings:

- Select Enable Host Monitoring
- Select Enable Admission Control
- Configure the admission control policy to support up to 1 ESXi host failure

Note:
Uncheck the Enable Host Monitoring” option when doing network maintenance, 
otherwise, the vSphere HA may detect a false failure.
To support vSphere HA failover, it is recommended to have reserve ESXi host(s) or 
a percentage of resources on each host reserved. These settings vary based on your 
preferences and available ESXi resources.

• In the vSphere HA > Virtual machine options, select the Primary EPM
- Set VM Restart Priority to High
- Set Host Isolation Response to Leave powered on.

These settings allow the Primary EPM virtual machine the highest priority for resources to 
reduce its downtime during a failure. The MPPs, Auxiliary EPMs, and other pieces to the 
Experience Portal infrastructure have the next highest priority.

• Go to vSphere HA > Virtual Monitoring, select the Primary EPM:
- Enable VM and Application Monitoring
- Set VM Monitoring Sensitivity to High
- Set Application Monitoring to Include

These settings allow the Primary EPM to restart if a heartbeat is not received in 30 
seconds. A custom Monitoring sensitivity rule can also be defined and used.

• Go to vSphere HA > Datastore Heartbeating and select the following:
- Check Select any of the cluster datastores taking into account my preferences.
- In the Datastores available for Heartbeat window, select the datastore where the Primary 

EPM VM is running.

Note:
Your configuration varies based on which failover scenarios and available resources to cover 
an HA failover scenario. For more information, see Create a vSphere HA cluster on VMware 
docs.
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vMotion: Host migration and storage vMotion
vMotion allows live migrations of virtual machines from one ESXi host to another. Storage vMotion 
allows live migration from one datastore to another. These migrations are done without any 
downtime of the migrating virtual machines. However, there may be some side effects when 
migrating virtual machines running Experience Portal servers.

• vMotion is supported in Maintenance Mode only.
• vMotion is not supported in Production for performance reasons.
• Storage vMotion is not supported as it might impact realtime application behaviour and event 

processing on the associated virtual machines.

Distributed Resource Scheduling
The following are the best practices specific to Experience Portal:

• The Distributed Resource Scheduling (DRS) Manual automation level setting suggests which 
virtual machines to be migrated. If they are Experience Portal machines, vMotion best 
practices should be applied to prevent any side effects during vMotion.

• The DRS Partially automated automation level setting contains the Manual feature and 
adds the feature to automatically place virtual machines on a host when it is powered on. 
This setting can be used with Experience Portal virtual machines if all the ESXi hosts in the 
cluster meet the hardware requirements to run Experience Portal on VMware vSphere.
For example, a cluster with multiple ESXi hosts have CPU cores ranging from 2 GHz to 3 
GHz. When an MPP running on an ESXi host with 3 GHz cores is powered off, the partially 
automated DRS places the MPP on an ESXi host with 2 GHz cores when powered on. As 
a result, the MPP is now running with fewer CPU resources, which can affect the system 
performance and capacity.

• The DRS Fully automated automation level setting for Experience Portal virtual machines is 
not supported. The Fully automated setting allows the automatic vMotion of virtual machines.

Fault Tolerance
The traditional Fault Tolerance feature is not supported with virtual machines using more than 1 
CPU. All Experience Portal virtual servers are configured with 4 CPUs. Therefore, fault tolerance 
cannot be configured.
In vSphere 6.0, VMware introduced Symmetric Multi-Processing Fault Tolerance (SMP-FT), which 
currently supports up to 4 CPUs. This feature is not tested with Experience Portal.

Site Recovery Manager
Site Recovery Manager (SRM) is a disaster recovery solution that allows for geographic 
redundancy of virtual machines across sites and various recovery and migration options. SRM 
has is not yet tested with Experience Portal.

Best practices for VMware vSphere
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Rescaling OVA hardware settings
Procedure

1. Shutdown the MPP/EPM that you want to rescale.

2. Power-off the virtual machine.

3. In vConsole, right-click the virtual machine, and click Settings.

4. Change the CPU/Memory to the target value that you want to set, and click Save.

5. Power-on the virtual machine again.

Best practices for VMware vSphere
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Chapter 9: Troubleshooting

Troubleshooting logs for Experience Portal deployment
The following set of logs, applicable to both vCenter or direct ESXi deployment types, are 
available in the /opt/Avaya/VE/logs directory:

• reconfigureNetwork.<YYYY-MM-DD>.log: This log contains information on the network 
configuration and re-configuration activities. If network re-configuration/configuration fails, 
use this log to understand and debug the root cause.

• reconfigureSystem.<YYYY-MM-DD>.log: This log records the various activities during 
the first boot up of the virtual machine post the OVA deployment. This log contains 
information about the networking state, condition and status of the custom services invoked 
(related to the OVA), and EP configuration state and status.

• DeployExperiencePortal.<YYYY-MM-DD>.log: This log records activities related to 
the Experience Portal deployment based on the DeployExperiencePortal program. The 
DeployExperiencePortal program determines if the deployed OVA is a primary EPM, auxiliary 
EPM, or MPP.

• DeployPrimaryEPM.<YYYY-MM-DD>.log, DeployAuxiliaryEPM.<YYYY-MM-
DD>.log, or DeployMPP.<YYYY-MM-DD>.log: This log records activities related to the 
primary EPM, auxiliary EPM, and MPP deployment. If there are issues in the deployments, 
use this log to debug the issues.

VMware generated core images on Experience Portal 
virtual machine images

VMware provides technical assistance for debugging virtual machine issues such as VM kernel 
panic, virtual machine that hangs, and so on. When you log a service request, you must send the 
performance snapshots to troubleshoot the issue. You can execute the vm-support command to 
collect the virtual machine logs. The vm-support command also creates a .tar file for sending the 
logs to VMware. You can debug the core image by using the Red Hat Crash Utility as described in 
Collecting performance snapshots using vm-support.
VMware also provides a utility to help you to take an initial look at virtual machine issues such 
as VM kernel panic, slow response time, virtual machine that hangs, and so on. The utility, called 
vmss2core, is a command line tool for creating virtual machine core file that you can use with 
the Red Hat crash utility. For the vmss2core command, see VMware Knowledge Base, which 
includes the vmss2core technical link. The vmss2core tool generates a vmcore core file, using the 
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virtual machine’s .vmsn file from a snapshot, or the .vmss file from a suspended virtual machine. 
For the Red Hat crash utility, see White paper: Red Hat Crash Utility.

Note:
When you run the vmss2core tool as the sroot user, ignore the "you are not root" message.

IP address fields clipped when deploying via vCenter
When you deploy the Experience Portal OVA via vCenter, the installer displays a Properties 
window where you have to enter the Linux network and Experience Portal specific parameters. 
Several of the fields on the Properties window accept input in the IP address format. On some 
systems, the vSphere Client program might clip the IP address fields so that only the first three 
octets of the address are visible. You might have to scroll the Properties window to see the fourth 
octet of the IP address.

System prompt to configure Experience Portal after 
deploying OVA with vCenter

When you deploy the Experience Portal OVA with vCenter, the vSphere Client OVF deployment 
wizard prompts you to enter the configuration values. The values are applied to the virtual 
machine only after you boot the virtual machine for the first time. It can take several minutes 
during the initial boot for the configuration process to complete. During the configuration process, 
if you log in to Linux remotely, the system might display a message stating that Experience 
Portal has not been configured. If the system prompts you to configure Experience Portal, do the 
following:

1. Respond with a no to the system prompt.
2. Log out of the remote Linux session.
3. After the boot process is complete, log in to Linux through the console.
4. Verify that the system does not display deployment errors on the console.

After the Experience Portal configuration process is complete on the virtual machine, the system 
does not prompt you to configure Experience Portal when you log in to Linux remotely.

ProductID must be configured for the VM to power on
If you enter an invalid or blank Product ID during the Primary EPM OVA deployment, the system 
displays an error message when the virtual machine is powered on. The error message is a 
follows:
Property 'ProductID' must be configured for the VM to power on

IP address fields clipped when deploying via vCenter
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To correct the error, perform the following steps:
1. Log into vSphere Client.
2. Right-click on the virtual machine being deployed, and select the Edit Settings option.
3. Select the Options tab. 
4. Select vApp Options > Properties. 

The system display the properties specified during the OVA deployment.
5. Enter the correct information in the Product ID field.
6. Click OK to save the changes.
7. Power on the virtual machine.

Troubleshooting
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Chapter 10: Resources

Documentation
The following table lists the documents related to Avaya Experience Portal. Download the 
documents from the Avaya Support website at http://support.avaya.com.

Title Description Audience
Avaya Experience Portal 
Documentation Roadmap

Lists all the documents related 
to Experience Portal and 
describes the organization of 
content across the documents.

Avaya Professional Services

Implementation engineers

Administering Avaya 
Experience Portal

Provides general information 
about and procedures for 
administering and configuring 
specific Experience Portal 
functions and features using a 
web-based interface.

Administrators

Implementation engineers

Avaya Experience Portal 
Overview and Specification

Describes tested product 
characteristics and capabilities, 
including product overview 
and feature descriptions, 
interoperability, performance 
specifications, security, and 
licensing requirements.

Administrators

Sales engineers

Implementation engineers

Avaya Professional Services

Implementing Avaya 
Experience Portal on a single 
server

Provides procedures to install 
and configure the Avaya 
Experience Portal software on a 
single server.

Implementation engineers

Implementing Avaya 
Experience Portal on multiple 
servers

Provides procedures to install 
and configure Avaya Experience 
Portal software on two or more 
dedicated servers.

Implementation engineers

Table continues…
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Title Description Audience
Deploying Avaya Experience 
Portal in an Avaya Customer 
Experience Virtualized 
Environment

Provides procedures for 
deploying the Experience Portal 
virtual application in the 
Avaya Customer Experience 
Virtualized Environment. 
This document includes 
installation, configuration, initial 
administration, troubleshooting, 
and basic maintenance 
checklists and procedures.

Implementation engineers

Upgrading to Avaya 
Experience Portal 8.1

Describes how to upgrade your 
Avaya Experience Portal system 
to Avaya Experience Portal 8.1.

Implementation engineers

Troubleshooting Avaya 
Experience Portal

Provides general information 
about troubleshooting and 
resolving system problems. This 
document also provides detailed 
information and procedures for 
finding and resolving specific 
problems.

Administrators

Implementation engineers

Avaya Professional Services

Avaya Experience Portal 
Solutions Guide

Provides a high-level description 
of Avaya Experience Portal 
as well as topology 
diagrams, connectivity details, 
interoperability concept, product 
interactions, and failover best 
practices.

Sales engineers

Implementation engineers

Avaya Professional Services

Avaya Experience Portal 
Programmer's Reference

Provides information about 
designing speech applications 
for Avaya Experience Portal.

Application Developers

Deploying Avaya Experience 
Portal on Amazon Web 
Services

Provides procedures for 
deploying Avaya Experience 
Portal as Software as a Solution 
by using the Amazon Web 
Services Management console.

Administrators

Implementation engineers

Support Personnel

Avaya Professional Services
Deploying Avaya Experience 
Portal on Google Cloud 
Platform

Provides procedures for 
deploying Avaya Experience 
Portal as Software as a Solution 
by using the Google Cloud 
Platform.

Administrators

Avaya Professional Services

Implementation engineers

Support Personnel
Table continues…
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Title Description Audience
Deploying Avaya Experience 
Portal on Microsoft Azure

Provides procedures for 
deploying Avaya Experience 
Portal as Software as a Solution 
by using the Microsoft Azure 
portal.

Administrators

Implementation engineers

Support Personnel

Avaya Professional Services
Avaya Experience Portal 
Security White Paper

Provides information about 
the security strategy for 
Experience Portal, and provides 
suggestions that companies can 
use to improve the security of 
the Experience Portal systems 
and applications.

Avaya Professional Services

Implementation engineers

Avaya Experience Portal 
Mobile Web Best Practices 
White Paper

Provides recommended 
strategies for deploying Avaya 
Orchestration Designer Mobile 
Web applications with Avaya 
Experience Portal, detailing 
configuration for security, 
scalability and high availability.

Avaya Professional Services

Implementation engineers

Avaya Experience Portal Call 
Classifications White Paper

Provides information about 
the call classification feature 
in Avaya Experience Portal, 
detailing the configuration and 
tuning of the call progress 
engine.

Sales engineers

Implementation engineers

Avaya Experience Portal 
Dialogflow White Paper

Provides information about 
connecting Avaya Experience 
Portal self-service applications 
to Google Dialogflow. This 
document provides details on 
configuration, licensing, and 
other information to help 
customers with Dialogflow 
integration.

Avaya Professional Services

Implementation engineers

Avaya Experience Portal 
Nuance Mix Integration White 
Paper

Provides information about 
connecting Avaya Experience 
Portal to Nuance Mix. This 
document provides details on 
configuration, licensing, and 
other information to help 
customers with Nuance Mix 
integration.

Avaya Professional Services

Implementation engineers

Finding documents on the Avaya Support website
Procedure

1. Go to https://support.avaya.com.

Documentation
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2. To log in, click Sign In at the top of the screen and then enter your login credentials when 
prompted.

3. Click Product Support > Documents.

4. In Search Product, start typing the product name and then select the appropriate product 
from the list displayed.

5. In Select Release, select the appropriate release number.

This field is not available if there is only one release for the product.

6. (Optional) In Enter Keyword, type keywords for your search.

7. From the Select Content Type list, select one or more content types.

For example, if you only want to see user guides, click User Guides in the Select Content 
Type list.

8. Click  to display the search results.

Avaya Documentation Center navigation
For some programs, the latest customer documentation is now available on the Avaya 
Documentation Center website at https://documentation.avaya.com.

Important:

For documents that are not available on Avaya Documentation Center, click More Sites > 
Support on the top menu to open https://support.avaya.com.

Using the Avaya Documentation Center, you can:

• Search for keywords.

To filter by product, click Filters and select a product.

• Search for documents.

From Products & Solutions, select a solution category and product, and then select the 
appropriate document from the list.

• Sort documents on the search results page.

• Click Languages ( ) to change the display language and view localized documents.

• Publish a PDF of the current section in a document, the section and its subsections, or the 
entire document.

• Add content to your collection using My Docs ( ).

Navigate to the Manage Content > My Docs menu, and do any of the following:

- Create, rename, and delete a collection.

- Add topics from various documents to a collection.

- Save a PDF of the selected content in a collection and download it to your computer.

Resources
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- Share content in a collection with others through email.

- Receive collection that others have shared with you.

• Add yourself as a watcher using the Watch icon ( ).

Navigate to the Manage Content > Watchlist menu, and do the following:

- Enable Include in email notification to receive email alerts.

- Unwatch selected content, all content in a document, or all content on the Watch list page.

As a watcher, you are notified when content is updated or deleted from a document, or the 
document is removed from the website.

• Share a section on social media platforms, such as Facebook, LinkedIn, and Twitter.

• Send feedback on a section and rate the content.

Note:

Some functionality is only available when you log in to the website. The available functionality 
depends on your role.

Training
The following courses are available on the Avaya Learning website at http://www.avaya-
learning.com/. After logging into the website, enter the course code or the course title in the 
Search field and click Go to search for the course.

Course code Course title
4C00100V

4C00100I

Avaya Experience Portal Implementation

5C00090V

5C00090I

Avaya Experience Portal, Avaya Orchestration Designer, and Proactive Outreach 
Manager Maintenance and Troubleshooting

3C00093O Avaya Aura® Contact Center Experience Portal Technical Sales Knowledge 
Session

V: Virtual course

I: Instructor led course

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot 
Avaya products.

Training
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About this task
Videos are available on the Avaya Support website, listed under the video document type, and on 
the Avaya-run channel on YouTube.

• To find videos on the Avaya Support website, go to https://support.avaya.com/ and do one of 
the following:

- In Search, type Avaya Mentor Videos, click Clear All and select Video in the Select 
Content Type.

- In Search, type the product name. On the Search Results page, click Clear All and select 
Video in the Select Content Type.

The Video content type is displayed only when videos are available for that product.

In the right pane, the page displays a list of available videos.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and do 
one of the following:

- Enter a keyword or keywords in the Search Channel to search for a specific product or 
topic.

- Scroll down Playlists, and click a topic name to see the list of videos available. For 
example, Contact Centers.

Note:

Videos are not available for all products.

Policies for technical support of the Avaya Solutions 
Platform (ASP) 130

For more information on ASP 130, see Policies for technical support of the Avaya Solutions 
Platform (ASP) 130 on the Avaya Support site.

Technical onboarding of Avaya Experience Portal 7.x and 
8.x

For more information see, How to Register and Onboard Avaya Experience Portal on the Avaya 
Support website.

Resources
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Support
Go to the Avaya Support website at https://support.avaya.com for the most up-to-date 
documentation, product notices, and knowledge articles. You can also search for release notes, 
downloads, and resolutions to issues. Use the online service request system to create a service 
request. Chat with live agents to get answers to questions, or request an agent to connect you to a 
support team if an issue requires additional expertise.

Support
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Appendix A: Experience Portal specific 
best practices for VMware 
features

The following sections describe the Experience Portal-specific best practices for VMware features.
For more information on the general best practices for performance and VMware features, see 
Customer Experience Virtualized Environment Solution Description.

Performance Monitor
Use the esxtop tool on the ESXi host to monitor the performance of your virtual machines. 
The following articles provide useful information on esxtop:

• Performance Monitoring Utilities: resxtop and esxtop: http://pubs.vmware.com/vsphere-51/
index.jsp?topic=%2Fcom.vmware.vsphere.monitoring.doc%2FGUID-A31249BF-B5DC-455B-
AFC7-7D0BBD6E37B6.html

• Interpreting esxtop Statistics: http://communities.vmware.com/docs/DOC-9279

vMotion: Host migration and storage vMotion
vMotion allows live migrations of virtual machines from one ESXi host to another. Storage vMotion 
allows live migration from one datastore to another. These migrations are done without any 
downtime of the migrating virtual machines. However, there may be some side effects when 
migrating virtual machines running Experience Portal servers.

• vMotion is supported in Maintenance Mode only.
• vMotion is not supported in Production for performance reasons.
• Storage vMotion is not supported as it might impact realtime application behaviour and event 

processing on the associated virtual machines.
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High Availability
High Availability (HA) is an option for Experience Portal to restart critical systems in the case of an 
ESXi host failure or general failure with the virtual machine.
Virtual servers running on a failed ESXi host experiences downtime until the virtual servers starts 
on another host in the HA cluster. The downtime is the time to detect the failure plus the time for 
the virtual machine to power on and startup.
VMware recommends using a secondary NIC for the management network when configuring HA, 
although it is not required.
The following are the recommended configuration to set up an HA cluster to be used with 
Experience Portal virtual machines:

• Each MPP must be configured with Restart Automatically set to Yes in EPM. To check the 
MPP setting, go to EPM > System Configuration > MPP Servers and click the MPP server 
name.

• Enable the HA cluster feature by checking Turn On vSphere HA.
• Go to vSphere HA cluster settings:

- Select Enable Host Monitoring
- Select Enable Admission Control
- Configure the admission control policy to support up to 1 ESXi host failure

Note:
Uncheck the Enable Host Monitoring” option when doing network maintenance, 
otherwise, the vSphere HA may detect a false failure.
To support vSphere HA failover, it is recommended to have reserve ESXi host(s) or 
a percentage of resources on each host reserved. These settings vary based on your 
preferences and available ESXi resources.

• In the vSphere HA > Virtual machine options, select the Primary EPM
- Set VM Restart Priority to High
- Set Host Isolation Response to Leave powered on.

These settings allow the Primary EPM virtual machine the highest priority for resources to 
reduce its downtime during a failure. The MPPs, Auxiliary EPMs, and other pieces to the 
Experience Portal infrastructure have the next highest priority.

• Go to vSphere HA > Virtual Monitoring, select the Primary EPM:
- Enable VM and Application Monitoring
- Set VM Monitoring Sensitivity to High
- Set Application Monitoring to Include

These settings allow the Primary EPM to restart if a heartbeat is not received in 30 
seconds. A custom Monitoring sensitivity rule can also be defined and used.

High Availability
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• Go to vSphere HA > Datastore Heartbeating and select the following:
- Check Select any of the cluster datastores taking into account my preferences.
- In the Datastores available for Heartbeat window, select the datastore where the Primary 

EPM VM is running.

Note:
Your configuration varies based on which failover scenarios and available resources to cover 
an HA failover scenario. For more information, see Create a vSphere HA cluster on VMware 
docs.

VM Snapshots
The following are the best practices specific to Experience Portal:

• Experience Portal is a real-time application. Ensure that Experience Portal is not running 
when you take a snapshot or revert to a snapshot.

• To prevent the side effects, shut down the virtual machine when you take or revert to a 
snapshot. Otherwise, the running systems may experience side effects such as dropped 
calls, web sessions, and servers out of sync.

• If you take a snapshot of a live EPM virtual machine, and revert the snapshot, you must 
restart the EPM service from the command line to resynchronize the Experience Portal 
environment.

Note:
Log in to the console as sroot and run the service vpms restart command.

• If you take a snapshot of a live MPP virtual machine, and revert the snapshot, you must 
restart the MPP to re-synchronize the system.

Note:
Restart the MPP from the System Management > MPP Manager page in EPM.

• After reverting a snapshot, and when the system is running, ensure that you delete all 
snapshots for the virtual machine in Snapshot Manager. The overhead of running with 
snapshots can impact the system performance, especially with disk I/O.

• For more information, see best practices for using virtual machine snapshots in the vSphere 
environment article in the VMware knowledge base.

Fault Tolerance
The traditional Fault Tolerance feature is not supported with virtual machines using more than 1 
CPU. All Experience Portal virtual servers are configured with 4 CPUs. Therefore, fault tolerance 
cannot be configured.

Experience Portal specific best practices for VMware features
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In vSphere 6.0, VMware introduced Symmetric Multi-Processing Fault Tolerance (SMP-FT), which 
currently supports up to 4 CPUs. This feature is not tested with Experience Portal.

Fault Tolerance
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Glossary

Application A software solution development by Avaya that includes a guest operating 
system.

Blade A blade server is a stripped-down server computer with a modular design 
optimized to minimize the use of physical space and energy. Although 
many components are removed from blade servers to save space, 
minimize power consumption and other considerations, the blade still has 
all of the functional components to be considered a computer.

EASG Enhanced Access Security Gateway. The Avaya Services Logins to 
access your system remotely. The product must be registered using the 
Avaya Global Registration Tool for enabling the system for Avaya Remote 
Connectivity.

ESXi A virtualization layer that runs directly on the server hardware. Also 
known as a bare-metal hypervisor. Provides processor, memory, storage, 
and networking resources on multiple virtual machines.

Hypervisor A hypervisor is also known as a Virtual Machine Manager (VMM). A 
hypervisor is a hardware virtualization technique which runs multiple 
operating systems on the same shared physical server.

MAC Media Access Control address. A unique identifier assigned to network 
interfaces for communication on the physical network segment.

OVA Open Virtualization Appliance. An OVA contains the virtual machine 
description, disk images, and a manifest zipped into a single file. 
The OVA follows the Distributed Management Task Force (DMTF) 
specification.

PLDS Product Licensing and Download System. The Avaya PLDS provides 
product licensing and electronic software download distribution.

Reservation A reservation specifies the guaranteed minimum required amounts of 
CPU or memory for a virtual machine.

SAN Storage Area Network. A SAN is a dedicated network that provides 
access to consolidated data storage. SANs are primarily used to make 
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storage devices, such as disk arrays, accessible to servers so that the 
devices appear as locally attached devices to the operating system.

Snapshot The state of a virtual appliance configuration at a particular point 
in time. Creating a snapshot can affect service. Some Avaya virtual 
appliances have limitations and others have specific instructions for 
creating snapshots.

Storage vMotion A VMware feature that migrates virtual machine disk files from one data 
storage location to another with limited impact to end users.

vCenter Server An administrative interface from VMware for the entire virtual 
infrastructure or data center, including VMs, ESXi hosts, deployment 
profiles, distributed virtual networking, and hardware monitoring.

virtual appliance A virtual appliance is a single software application bundled with an 
operating system.

VM Virtual Machine. Replica of a physical server from an operational 
perspective. A VM is a software implementation of a machine (for 
example, a computer) that executes programs similar to a physical 
machine.

vMotion A VMware feature that migrates a running virtual machine from one 
physical server to another with minimal downtime or impact to end users. 
vMotion cannot be used to move virtual machines from one data center to 
another.

VMware HA VMware High Availability. A VMware feature for supporting virtual 
application failover by migrating the application from one ESXi host to 
another. Since the entire host fails over, several applications or virtual 
machines can be involved. The failover is a reboot recovery level which 
can take several minutes.

vSphere Web Client The vSphere Web Client is an interface for administering vCenter Server 
and ESXi. Downloadable versions are VMware 5.5 and 6.0. A browser-
based Web client version is VMware 6.5 and later.

Snapshot
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